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Abstract
The Shoreline Management Tool is a geographic information system (GIS) based program
developed to assist water- and land-resource managers in assessing the benefits and effects of changes
in surface-water stage on water depth, inundated area, and water volume. Additionally, the Shoreline
Management Tool can be used to identify aquatic or terrestrial habitat areas where conditions may be
suitable for specific plants or animals as defined by user-specified criteria including water depth, landsurface slope, and land-surface aspect. The tool can also be used to delineate areas for use in
determining a variety of hydrologic budget components such as surface-water storage, precipitation,
runoff, or evapotranspiration.
The Shoreline Management Tool consists of two parts, a graphical user interface for use with
Esri™ ArcMap™ GIS software to interact with the user to define scenarios and map results, and a
spreadsheet in Microsoft® Excel® developed to display tables and graphs of the results. The graphical
user interface allows the user to define a scenario consisting of an inundation level (stage), land areas
(parcels), and habitats (areas meeting user-specified conditions) based on water depth, slope, and aspect
criteria. The tool uses data consisting of land-surface elevation, tables of stage/volume and stage/area,
and delineated parcel boundaries to produce maps (data layers) of inundated areas and areas that meet
the habitat criteria. The tool can be run in a Single-Time Scenario mode or in a Time-Series Scenario
mode, which uses an input file of dates and associated stages. The spreadsheet part of the tool uses a
macro to process the results from the graphical user interface to create tables and graphs of inundated
water volume, inundated area, dry area, and mean water depth for each land parcel based on the userspecified stage. The macro also creates tables and graphs of the area, perimeter, and number of polygons
comprising the user-specified habitat areas within each parcel.
The Shoreline Management Tool is highly transferable, using easily generated or readily available
data. The capabilities of the tool are demonstrated using data from the lower Wood River Valley
adjacent to Upper Klamath and Agency Lakes in southern Oregon.
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Introduction
Water-, land-, and wildlife-resource managers responsible for water bodies or land areas adjacent to
shorelines must balance multiple competing needs when managing surface-water levels with regard to
water quantity, water depth, area of inundation, and area of dry land. These may include issues related
to water supply, water quality, shoreline habitat for plants or animals, and human use of water and land
areas.
Assessing the effects of changing surface-water levels can be difficult because of the limitations
and accessibility of existing data. Quantification of the benefits could be improved by assembling
information on relations between surface-water levels, water storage, area of inundation, water depth,
and local habitat conditions, and by developing a tool to facilitate analysis of the data for past, present,
or future conditions. Such a tool could assist natural-resource managers in making informed decisions
about changing surface-water stage.
In 2006, the U.S. Geological Survey (USGS), in cooperation with the Bureau of Land Management
(BLM), began a study to analyze high-resolution elevation data for the lower Wood River Valley in
southern Oregon and to create an interactive tool within a geographic information system (GIS) to
evaluate various shoreline management scenarios. The first phase in developing this tool was to develop
data tables, maps, and graphs depicting the estimated volumetric storage of water and the quantity and
location of inundated areas for various water stages. The results of Phase 1 are presented in a report by
Haluska and Snyder (2007).
In 2010, the USGS and BLM agreed to continue this effort and conduct the second phase of the
study, which involved the development of the interactive GIS programs and spreadsheets that make up
the Shoreline Management Tool. The tool allows users to specify the input data and criteria for analysis,
process the data, and create results in the form of maps, data tables, and graphs. The tool developed in
Phase 2 is designed for use by natural-resource managers to evaluate water, land, and habitat conditions
on the basis of various factors specified by the user. Although the tool was initially developed to
evaluate conditions in the lower Wood River Valley, Oregon, it is designed to be transferable to other
areas using easily generated or readily available data.

Purpose and Scope
The purpose of this report is to document the Shoreline Management Tool, which consists of an
interactive graphical user interface for ArcMap™ GIS (Environmental Systems Research Institute, Inc.
[Esri™]) and an output spreadsheet for Excel® (Microsoft® Corp.). Also included in this report are the
results from Phase 1 of the study, consisting of the GIS data required by the Shoreline Management
Tool for use in an example implementation for the lower Wood River Valley in southern Oregon and
instructions on how to run the tool using the example data.
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The Shoreline Management Tool
The Shoreline Management Tool consists of a graphical user interface developed for ArcMap to
accept user input, process the data, and display maps of the results, as well as a spreadsheet containing
macros that automatically develop tables and graphs of the results. The tool can assist resource
managers in estimating surface-water volume, inundated area, dry area, and mean water depth at various
surface-water stages as well as identifying potential habitats. As used in this report, “habitat” refers to
an area that meets a set of criteria specified by the user within the tool. These criteria can include water
depth, land-surface slope, and land-surface aspect (direction that the slope faces). Habitats defined in
this manner can be used to identify the place or environment (aquatic or terrestrial) where conditions are
suitable for a particular plant or animal to live and grow. Habitats also can be defined as areas for use in
determining a variety of hydrologic budget components, such as surface-water storage, precipitation,
runoff, open-water evaporation, evapotranspiration, or groundwater discharge. The tool uses ArcMap
and data consisting of land-surface elevation, tables of stage/volume and stage/area, and delineated
boundaries of land areas (parcels) to calculate and display scenarios as specified by the user. Scenarios
consist of: one or more groups of parcels; a single surface-water stage or a time-series of surface-water
stages; and habitats defined by water depth, and the slope and aspect of the land surface.
The Shoreline Management Tool User’s Guide is presented in appendix A. Instructions for
preparation of input data for the Shoreline Management Tool are presented in appendix B. Information
on example data files for the lower Wood River Valley for use with the Shoreline Management Tool is
presented in appendix C. Examples of Python programming language scripts for automating processing
of the input data needed for the Shoreline Management Tool are presented in appendix D.

Description of the Program
The first part of the Shoreline Management Tool consists of an Add-in developed for ArcMap that
contains the programming for an interactive graphical user interface to accept user input, process data,
and prepare output that can then be displayed in ArcMap. The second part of the Shoreline Management
Tool consists of Excel files containing macros to further process the output from the graphical user
interface and display tables and graphs of the results.

Description of Input Data
The following sections describe the input data required for the Shoreline Management Tool.

Parcel Layer
The tool requires a file geodatabase (an ESRI ArcMap formatted spatial database of geographic
information stored as a folder of files) that must contain a polygon FeatureClass (database field) named
“Parcels” that divides the study area into smaller areas of interest. A FeatureClass is a collection of
geographic features with the same geometry type (such as point, line, or polygon), the same database
attributes, and the same spatial reference (Environmental Systems Research Institute, Inc., 2012a).
FeatureClasses are often stored in a FeatureDataset consisting of a collection of FeatureClasses that
share the same spatial reference and have features that fall within a common geographic area, although
they may have different geometry types. However, it is important to note that the Parcels FeatureClass
must be inside the geodatabase, but not within a FeatureDataset in the geodatabase. The parcel
delineations can be based on land ownership, land use, topography, geographic features, or any other
attributes of significance to the user.
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Digital Elevation Model
The Shoreline Management Tool requires a Digital Elevation Model (DEM) consisting of a raster
of land-surface elevations that covers the entire study area. A raster is defined as a rectangular grid of
cell-based data, where all the cells are square, have uniform dimensions, have an area that is equal to the
square of the cell edge length, and have edges that align with the X and Y directions of a particular
projected coordinate system. Each DEM raster cell has an assigned elevation (in units of length) that is
representative of the land-surface area within the cell relative to a specific horizontal datum. The DEM
is used to create rasters of water depth by subtracting the land-surface DEM from a user-specified water
elevation. This value is used to determine whether an area will be inundated in a particular scenario and
the resulting water depths. These water depth rasters are sometimes referred to as “depth grids,” “flooddepth grids,” or “flood-inundation maps” by agencies such as the Federal Emergency Management
Agency (FEMA) or National Oceanic and Atmospheric Administration (NOAA). The DEM is also used
to develop stage-volume and stage-area relationships for each parcel to determine water volumes,
inundated areas, and mean depths for the parcels (see the section “Data Tables”). The Shoreline
Management Tool requires the input DEM to have ground units and elevation values in meters. DEMs
using other ground units will require projection into units of meters. DEMs using other units of
elevation will require preprocessing to convert the elevation values to meters before use with the tool
(see “Conversion Factors and Datums” and “Digital Elevation Model” in Appendix B). The DEM may
be optionally processed to develop rasters of slope and aspect of the land-surface for comparison with
the user-specified habitat definitions if these criteria are desired (see the section “Slope and Aspect
Rasters” in appendix B). There are many sources of DEM data. The USGS National Elevation Dataset
provides access to a variety of DEM data (U.S. Geological Survey, 2012).

Inundation Layers
As an option, the user may pre-process the DEMs to create GIS layers showing the shoreline of the
inundated area at various increments of surface-water stage (in units of length) relative to a specific
horizontal datum. This pre-processing is not currently performed by the tool and must be done by the
user. A Python programming language script (Python Script to Create DEM, Slope, and Aspect Rasters,
and Shoreline Polygons) is provided as an example for automating a part of the process to prepare the
optional inundation layers (appendix D). If developed, the GIS layers of inundation, in the format of file
geodatabase polygon FeatureClasses, can be used to show the area of land that is inundated by water
with a change in surface-water stage for use with the Shoreline Management Tool. The tool is currently
programmed to use inundation layers, if available, for every 0.1 ft of surface-water stage. User-specified
surface-water stages will be rounded to the nearest 0.1 ft for selection and display of inundation layers
in the output created by the Shoreline Management Tool.
The Shoreline Management Tool assumes that all areas above the user-specified surface-water
stage will be dry (completely drained) and that all areas below will be inundated (completely filled).
However, on the actual landscape, as parcels are filled or drained, the areas of inundation in a parcel
might depend on inflow and outflow locations. During the filling of a parcel, isolated internal
topographically low areas might not become inundated until water in adjacent low areas overtops the
intervening land surface. During the draining of a parcel, water in isolated topographically low areas
might not be emptied. To determine the actual inundation during filling or draining, information on the
location of the inflows and outflows and the use of a hydraulic flow-routing model, which was beyond
the scope of this study, would be required. Additionally, depending on soil permeability, groundwater
flow may tend to equalize surface-water levels within a parcel. For this report, it was assumed that all
areas would be inundated below the specified surface-water stage and dry above the specified stage.
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Data Tables
Data tables containing lookup tables of surface-water stage and the associated volume and area
values must be calculated for each parcel in the parcel layer. The creation of these data tables is not
currently performed by the tool and must be done by the user. A Python programming language script
(Python Script to Create Stage Lookup Data Table) is provided as an example for automating a part of
the process to prepare the data tables (appendix D). The data tables consist of comma-delimited files
that should be constructed for each vertical datum required by the user, such as NAVD88 or NGVD29.
The data tables must have values of surface-water stage in feet, volume of storage in acre-feet, and area
of inundation in acres. Mean depth, although not required in the data table, can be calculated from the
data tables as the volume divided by the area. The Shoreline Management Tool is currently programmed
to look up values within the data tables with stage increments of 0.01 ft. Increments of user-specified
stage entered with greater precision will be rounded to the nearest 0.01 ft. The precision used for the
inundation layers is 0.1 ft (see section “Inundation Layers”).

Geoprocessing of Data
During the graphical user interface part of the Shoreline Management Tool, the user is guided
through a series of input forms used to specify the required data and to formulate a scenario for analysis
by the tool (fig. 1). Information entered by the user includes input/output pathnames and filenames,
source data, water-level stage, vertical datum, parcel selection, and habitat definitions. At the
completion, the user is instructed to “Run Scenario,” at which time the Shoreline Management Tool
begins geoprocessing of the data. The tool creates a water-depth raster for each parcel selected by the
user by creating a raster of the user-specified stage for each parcel and then subtracting the raster of the
DEM of the land-surface elevation for that parcel. Because the tool requires the input DEM to have
ground units and elevation values in meters, the rasters of the user-specified input stages, which are
created in feet, are converted by the tool to meters prior to subtracting the DEM. The output depth
rasters, in meters, are then converted to feet for the remaining geoprocessing and output. If slope and
aspect are to be used as criteria in the habitat definitions, then the rasters of slope and aspect must be
generated by the user prior to running the Shoreline Management Tool (see “Slope and Aspect Rasters”
in appendix B for details and appendix D for an example Python script for automating a part of the
process). The tool creates intermediate rasters meeting each individual criterion of depth, slope, and
aspect by parcel. It then creates a new intermediate raster from only those areas (raster cells) in
common, from the depth, slope, and (or) aspect rasters for each parcel. Cells in this raster meet all the
criteria as specified in the habitat definition. This raster is then used to generate an output polygon
shapefile of habitat areas for the parcel. Upon completion of geoprocessing, the Tool creates an ArcMap
map document with the output GIS layers for each parcel selected by the user consisting of the parcels,
inundation layers (if generated by the user prior to running the tool), habitat polygons, and optionally,
the depth raster. The user may choose to manually add the intermediate rasters consisting of habitat
depth, habitat slope, habitat aspect, and habitat areas if these were specified by the user to be stored. The
intermediate rasters can be used to determine the extent to which a particular habitat criterion is
constraining the results. The tool will also create text files with input and output data to be passed to the
Excel spreadsheet to further process the results using automated VBA macros.
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Figure 1. Screen capture showing example data entry screen for ArcMap graphical user interface from the
Shoreline Management Tool.

Description of Output Products
Output products of the Shoreline Management Tool consist of two components; an ArcMap map
document (.mxd file extension) and an Excel workbook (.xlsm file extension for macro enabled file).
The first output component, the ArcMap map document, contains and displays the land parcels and, for
each land parcel inundation layer (if provided by the user), polygon shapefiles of habitat areas and
ArcMap rasters of water depth (fig. 2). Rasters of several types of data are created as intermediate steps
in the processing of the graphical user interface part of the Shoreline Management Tool. During data
entry, the user is given the option of saving these “intermediate rasters,” which include values of depth,
slope, or aspect for areas meeting the habitat criteria, as well as intermediate rasters for each habitat that
indicate which raster cells meet all of the specified criteria. These rasters can be loaded manually into
the ArcMap map document. For a more complete description of the ArcMap output products, see
section “Detailed Output ArcMap Map Document Description” in appendix A.
The second output component, the Excel workbook, consists of worksheets containing stage,
volume, area, and mean depth statistics by parcel groups, parcel, and habitat (fig. 3) that are created by
clicking on a single button to run a macro that loads and processes the data output from the graphical
user interface part of the tool. For runs using the Time-Series Scenario mode, the Excel workbook also
includes time-series graphs illustrating stage, volume, area, mean depth, and habitat. For a more
complete description of the Excel output products, see section “Detailed Excel Worksheet Output
Description” in appendix A.
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Figure 2. Screen capture showing example of the ArcMap map document output from the Shoreline Management
Tool
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Figure 3. Screen captures showing examples of the Excel Workbook output from the Shoreline Management Tool.
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An Example for the Lower Wood River Valley, Oregon
The Shoreline Management Tool study was initiated in part to address water- and land-resource
issues in the Upper Klamath Basin of southern Oregon. Natural-resource managers, responsible for
administering lake levels and lands adjacent to Upper Klamath and Agency Lakes in the basin, must
balance multiple competing water needs, such as downstream water use, instream flow requirements,
and maintenance of lake-margin habitats and conditions (including those required for fish species listed
under the Endangered Species Act). Wildlife managers have been interested in identifying areas of
potential wetlands along present and former shorelines within currently diked and drained lands
adjacent to both lakes and in the lower Wood River Valley in the central part of the basin. Additionally,
the recent Klamath Basin Restoration Agreement (KBRA), developed to provide a comprehensive
solution to ecological and water-supply issues in the Klamath River Basin, contains a component titled
“Wood River Wetland Restoration Project.” The goal of the project is to “reconnect Wood River
Wetland to Agency Lake when physical and biotic conditions are sufficient to provide the wetland
restoration benefits for which the property was acquired” (Klamath Basin Restoration Agreement, 2010,
Section 18.2.3, p. 122–123). The example of the Shoreline Management Tool for use in the lower Wood
River Valley (appendix C) can be used to assist natural-resource managers in making more informed
decisions about breaching dikes, changing surface-water stage, and designating potential habitat.
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Description of Shoreline Management Tool
The Shoreline Management Tool consists of two parts, a graphical user interface consisting of an
Add-in (ShorelineAddin) developed for ArcMap, and Excel spreadsheets (SingleTime.xlsm and
TimeSeries.xlsm). The purpose of the graphical user interface is to gather input data and scenario
settings from a user, process the information, and provide output products based on that scenario. These
output products consist of:
1.
2.
3.
4.

GIS data layers of inundation areas;
user-defined potential habitat areas specified by water depth, slope, and (or) aspect;
rasters of depth, slope, and aspect by habitat and parcel (optional); and
text files of input and output data for use with the spreadsheet.
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The purpose of the spreadsheets is to process the results from the graphical user interface to create:
1. tables of data;
2. summary statistics related to the user-defined scenario; and
3. graphs showing relations of stage with area, volume, mean depth, and habitat.

Version Numbers
The version number of the Shoreline Management Tool is incorporated in the folder and filenames
as well as in the program itself. The version is specified using the date of the release with the format,
vYYYYMMDD, where “v” stands for “version”, “YYYY” is the year, “MM” is the month, and “DD” is
the day. When running the Shoreline Management Tool, the version number is shown when you select
the “About Shoreline Management Tool” button on the top of the tool window of the Shoreline
Management Tool. This version number also is present in the output file “Input_Data_Summary.txt.”
The spreadsheet part of the Shoreline Management Tool will display two version numbers, one for
the version number of the Shoreline Management Tool spreadsheet that is currently being run and, once
the macro for the spreadsheet is run, the version number that was used to create the input data for the
spreadsheet (see section “Detailed Excel Worksheet Output Description”). This may help to identify
incompatibilities of older datasets resulting from updates or changes in the data input format used by the
spreadsheets.

Tool Requirements
1. Operating System: Microsoft® Windows® XP Professional (version 2002, SP3) or Microsoft
Windows 7.
2. GIS Software: Esri™, ArcMap™ version 10 with Spatial Analyst extension. Tested with Service
Packs 2, 3, 4, and 5. Minimally tested with ArcMap version 10.1.
3. Microsoft Office Software: Excel® version 2010. Minimally tested with Excel version 2013. Note
that Excel version 2007 and Excel for Mac 2011 should work but have not been tested.
4. The download file containing the ShorelineDirectory folder (see section “Download Files”) must be
unzipped. Download files are provided for a generic version of the Shoreline Management Tool and
for an example implementation for the lower Wood River Valley in southern Oregon. The generic
version of the tool, intended for general use, contains no preprocessed data and requires
approximately 14 megabytes (MB) of disk space when unzipped. Additional space requirements
needed for the digital elevation model data, data layers with parcel boundaries, and data layers of the
areas of inundation by stage depend on the specific geographic area of implementation, data
availability, and data resolution. The version of the tool provided as an example implementation for
the lower Wood River Valley contains all data needed to run the tool and requires 10 gigabytes (GB)
each for the two vertical datums for which data are provided. Tool users will be prompted to specify
the location of the ShorelineDirectory when the tool is started within ArcMap.
5. In addition to the directory structure described in the section “Detailed Installation Instructions,” the
tool requires Geographic Information System (GIS) layers in the GIS_Layers and Processed_Data
folders as described in the section “Contents of ShorelineDirectory.” These data layers must be
prepared by the user.
Note: example files containing data layers are provided for 34 land parcels within the lower Wood
River Valley area consisting of pre-processed land-surface elevation data from a Digital Elevation
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Model (DEM), parcel boundaries, inundation layers, and lookup files. The data are provided in the
North American Vertical Datum of 1988 (NAVD88) and the National Geodetic Vertical Datum of
1929 (NGVD29). A zipfile of the ShorelineDirectory is provided for each datum. The GIS_Layers
folder contains land-surface elevation, slope, and aspect rasters processed from a DEM consisting of
LiDAR data for each of the 34 parcels in the study area at horizontal grid-cell resolutions of 1 and
5 m. The Processed_Data folder contains a file geodatabase contains inundation layers and a parcel
layer for the study area. In addition, the attribute table of the NGVD29 FeatureClasses has a field
that contains the Upper Klamath Lake Vertical Datum (UKLVD) equivalent for elevation (see
“Conversion Factors and Datums”).
6. Output directories will be created by the Shoreline Management Tool. A typical size for an output
directory with one group of two parcels and two habitats is about 5MB for the example
implementation for the lower Wood River Valley. The user must ensure disk space is available for
the output directories to be created.
7. The ShorelineDirectory folder must be accessible from ArcCatalog under “Folder Connections.”
This can be done using the ArcCatalog “Connect to Folder” button and navigating to the
ShorelineDirectory folder.

Download Files
Users may choose from three download files. One download file is a generic version of the
Shoreline Management Tool intended for general use. The other two download files contain
preprocessed data for use in the example implementation of the tool for the lower Wood River Valley,
Oregon. Each download file contains the add-in file and the ShorelineDirectory structure in which the
tool will operate and create output files. The download files are:
1. ShorelineManagementTool_OFR2012-1247_v20130123.zip
(Generic version for general use that contains no preprocessed data; about 5 MB zipped),
2. ShorelineManagementTool_NAVD88_OFR2012-1247_v20130123.zip
(Contains preprocessed data in NAVD88 for use with lower Wood River Valley, Oregon or as a
demonstration; about 2GB zipped), and
3. ShorelineManagementTool_NGVD29_OFR2012-1247_v20130123.zip
(Contains preprocessed data in NGVD29 for use with lower Wood River Valley, Oregon or as a
demonstration; about 2GB zipped).
The ShorelineDirectory folder in each zipfile contains several folders that the tool will use during
operation (fig. A1). Do not change the names of the folders. The tool will prompt the user to point to
this ShorelineDirectory folder; therefore, all users that will be running the Shoreline Management Tool
from this ShorelineDirectory folder must have read/write access to the folder.
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Figure A1. Screen capture showing the appearance of the ShorelineDirectory
folder for use with the Shoreline Management Tool.

Detailed Installation Instructions
1. Prepare program directories and files:
Unzip the zipped download files. The Shoreline Management Tool is a Microsoft Add-in that
typically requires no administrative rights for installation and can be easily shared among
ArcMap users.
2. Install Shoreline Management Tool add-in:
a. In ArcMap, select the Customize menu, and select Add-In Manager.
Select the Options tab, select Add Folder, browse to the unzipped ShorelineManagementTool
directory named ShorelineDirectory/Tool_Source_Files containing the add-in file, and click OK.
Click the Add-Ins tab, the “ShorelineAddin ” should now be listed under “Shared Add-Ins.”
Click on the ShorelineAddin and confirm the version date on the right side of the dialogue box.
This version date should match the version date in the zipfile name. From the Add-In Manager
select the Customize button.
Add the button for the Shoreline Management Tool add-in to an existing toolbar by selecting the
Commands tab at the top of the Customize dialog box.
After the Categories list box on the left side of the dialog box is populated, click the category named
“Add-In Controls” to see the commands available in the Commands list box on the right.
The icon for the button for the Shoreline Management Tool appears as a circle showing a cross
section of land, water, and sky (fig. A2). Drag the Shoreline Management Tool button to an
existing toolbar in ArcMap, then close the Customize dialog box.

Figure A2. Screen capture showing the icon for the Shoreline Management Tool button.
3. Enable Spatial Analyst extension and Environmental symbology style:
a. Enable the ArcMap Spatial Analyst extension. Under the Customize menu, select Extensions,
and check the box for Spatial Analyst.
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The Shoreline Management Tool uses the Environmental symbology style reference. Ensure that the
map document has this style reference loaded by clicking the Customize menu, and select Style
Manager. If the Environmental style folder is not listed in the left side of the window, click the
Styles… button on the right side of the window and check the “Environmental” check box. If
preferred, the user may add the Environmental style to the default style list by selecting “Set as
Default List….” Click OK, and close the Style Manager window.
4. Prepare parameter file:
a. Open the text file named …\ShorelineDirectory\Tool_Source_Files\tool_parameters.txt. Note
that this file must retain its name and location for use with the Shoreline Management Tool.
Values are initially set for use with the example implementation for the lower Wood River
Valley.
b. In the tool_parameters.txt file, enter the number of parcels in line 1 using the following format:
“Total Parcels,n” where “n” is the number of parcels from 1 to 99. Do not insert any spaces
before or after the comma. The maximum number of parcels is 99 (see “Parcel Layer” in the
“Explanation of Input Data” section of appendix B). The Shoreline Management Tool will use
this number to allocate space during the spreadsheet part of the tool.
c. In the tool_parameters.txt file enter the minimum and maximum water-stage elevations (in
feet) that apply to the DEM dataset(s) being used. The DEM dataset is described in the section
“Contents of ShorelineDirectory.” Line 2 should contain the minimum value of stage. Line 3
should contain the maximum value of stage. The Shoreline Management Tool will use these
minimum and maximum values as the valid range of stage. Values of water-stage elevation
entered by the user in the graphical user interface part of the tool that are outside this range
will generate an immediate warning to the user; another warning will be generated while using
the spreadsheet part of the tool. The minimum and maximum values of stage should be
selected on the basis of the availability of inundation layers (discussed in section “Inundation
Layers”) or the range of stages in the data tables (see section “Data Tables”). Note that values
of stage entered into the tool or annotated in the tool_parameters.txt file are in units of feet,
even though the DEM elevation values are in units of meters.
To prevent an error message, if using more than one geodatabase (such as NGVD29 and
NAVD88), the minimum value in the tool_parameters.txt should be assigned the maximum of
the minimum values of all geodatabases; the maximum value should be assigned the minimum
of the maximum values of all geodatabases. As an example, the tool_parameters.txt file is
initially set for use with the implementation for the lower Wood River Valley. Ensure that the
minimum and maximum stage values in the tool_parameters.txt file are valid for all data tables
and inundation FeatureClasses within each geodatabase. The tool_parameters.txt file is
initially set for 4,135.3 and 4176.3 ft, for use with the example implementation for the lower
Wood River Valley.
d. In the tool_parameters.txt file beginning with line 4, enter the DEM resolution value (in
meters) and the word “meter” for each resolution of the DEM in the GIS_Layers folder.
Following is an example of the tool_parameters.txt file for the lower Wood River Valley:
Total Parcels,34
4135.3
4176.3
1 meter
5 meter
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The file specifies that the total number of parcels is 34, the minimum stage is 4,135.3 ft, the
maximum stage is 4,176.3 ft, there is a 1-m resolution DEM, and a 5-m resolution DEM in the
GIS_Layers folder of the ShorelineDirectory.

Detailed Uninstall Instructions
If the Shoreline Management Tool is being upgraded to a new version or if the tool is no longer
required, it may be removed from ArcMap using the following instructions:
1.
2.
3.
4.
5.

Open ArcMap, select the Customize menu, and select Add-in Manager.
In the Add-in Manager window, select the Add-Ins tab.
If present, the Shoreline Management Tool should be listed under “Shared Add-Ins.”
In the Add-in Manager window, select the “Options” tab.
Select the directory specified during installation containing the Shoreline Management Tool add-in
and select “Remove Folder.”
6. Select the “Customize” button; select the “Commands” tab; drag the ShorelineManagementTool
button from the toolbar where it was placed during installation to somewhere outside of the ArcMap
window; and then click "Close.”

Known Actions that Will Cause the Shoreline Management Tool or ArcMap to Crash or May Cause
Unpredictable Behavior.
1. Do not run the Shoreline Management Tool unless the ArcMap Spatial Analyst extension is enabled.
The following message in the OutputMessagesFromScenarioRun.txt file may indicate that Spatial
Analyst has not been enabled: “Subroutine: DisplayDepthRange ERROR 010248: There are no
Spatial Analyst or 3D Analyst licenses currently available or enabled.” To resolve this issue follow
the instructions in the section “Detailed Installation Instructions,” item 3a.
2. Removing or modifying folders, folder names, or folder contents in the ShorelineDirectory folder
may result in errors or application crashes during Shoreline Management Tool operation.
3. Names of directory folders, filenames, ArcMap GIS files, ArcMap tables, or ArcMap fields having
spaces or special characters may result in errors or unpredictable behavior. The following naming
conventions should be adhered to:
a. Names should consist of alphanumeric characters. The only special character allowed is an
underscore.
b. The name must not contain spaces.
c. The name must start with a letter, not a number or an underscore.
4. Direct modification of the habitat definition or scenario definition text files using a file editor may
result in corruption of the expected information format that may cause the program to crash or may
cause unpredictable behavior.
5. Insufficient read/write access for the user to the ShorelineDirectory folder may result in errors or
incomplete processing.
6. Failure to load the Environmental symbology style reference will result in no symbology being
assigned to the layers consisting of the habitat polygon shapefiles. To resolve this issue follow the
instructions in the section “Detailed Installation Instructions,” item 3b.
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Quick Start Tool Operation Instructions
In ArcMap, click the icon for the Shoreline Management Tool button (fig. A2). Follow the yellow
highlighted buttons and instructions for inputting information into the tool. After clicking “Run
Scenario,” the tool will run the geoprocessing, and the output products will be placed in the output
folder that was designated during input. Open the Excel file in the designated output folder, and enable
macros. In the worksheet named Start, a button labeled either as “Load and Run Single-Time Scenario”
or “Load and Run Time-Series Scenario” will appear depending on the option selected by the user when
running the Shoreline Management Tool. Click the button to run the Visual Basic for Applications
(VBA) macro that will use the output from the graphical user interface part of the Shoreline
Management Tool to complete the processing of the results.

Detailed Tool Operation Instructions
Start by opening ArcMap, then activate the Shoreline Management Tool by clicking the add-in
button installed in ArcMap (fig. A2). The Shoreline Management Tool is designed to guide users
through the input steps by highlighting (in yellow) the next button or text box to be addressed. To
provide clarity, in this section of the report, the names of Shoreline Management Tool windows
containing dialog or information boxes are emphasized with italic text. The names of buttons, input
boxes, and check boxes within the tool are emphasized with bold text. After activating the Shoreline
Management Tool, the Scenario Settings dialog box will appear (fig. A3). If the ShorelineDirectory has
not been previously entered, the START HERE! button will be highlighted in yellow as an indication
that the location of the ShorelineDirectory (provided inside the downloaded zipfile) needs to be set.
After changing scenario settings, the selections are listed in the “Current Scenario Settings” area to the
right side of the Scenario Settings dialog box. If the ShorelineDirectory has been previously entered
during a prior session of the tool, this directory is automatically entered by the tool. The user may select
an alternate directory by using the Click here to change Shoreline Directory button to open the Select
the Shoreline Directory dialog box consisting of an ArcCatalog window, where the user may browse to
the desired directory; however, the selected directory must contain the files as described in the section
“Contents of ShorelineDirectory.”
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Figure A3. Screen capture showing the Shoreline Management Tool, Scenario Settings dialog box.
After setting the ShorelineDirectory, users are allowed to click the Introduction and Instructions
button in the top right corner of the Scenario Settings dialog box. This button will activate the
Introduction, Report Links, and User Instructions window providing a link to the USGS website to
access the report and data for the Shoreline Management, and a User’s Guide button that opens a
Portable Document Format (PDF) stored in the ShorelineDirectory folder. The About Shoreline
Management Tool button is available at any time and opens the About Shoreline Management Tool
window that contains the version number of the Shoreline Management Tool, contact information, and
disclaimers.
The Define Input GIS Layers button will be highlighted if the ShorelineDirectory is successfully
identified. At this point, the user may click the Define Input GIS Layers button and then proceed stepby-step through the parcel data layer selection (fig. A4), or the user can go directly to Load an Existing
Scenario File. An existing scenario file is one that has been previously defined with the Shoreline
Management Tool. The tool will look for scenario files in the ShorelineDirectory\Scenario_Definitions
folder.

18

Figure A4. Screen capture showing the Shoreline Management Tool, Define Input GIS Layers dialog box.
In the Define Input GIS Layers dialog box, users should use the drop-down menus to select their
preferred DEM resolution for raster processing in the scenario and the Parcel FeatureClass layer. The
available resolutions are assigned using the tool_parameters.txt file (see section “Detailed Installation
Instructions”). For the example implementation for the lower Wood River Valley, DEMs are provided
in resolutions of 1 m and 5 m. Smaller values of resolution result in better delineation of small or
intricate land-surface features, whereas larger values of resolution provide faster processing times. Note:
The inundation layers for scenarios for the example implementation for the lower Wood River Valley
were originally processed at a 1-m resolution; therefore, if users choose a 5-m resolution for their
scenario, any output habitats generated by the tool will be at a 5-m resolution and the cell boundaries
may not align perfectly with the 1-m inundation layers. In addition, the lookup tables of surface-water
stage and the associated volume and area were also generated at 1-m resolution which may result in
minor discrepancies in these values if users choose a 5-m resolution for their scenario.
If the parcel layer is already loaded into the map document, the parcel layer name will be listed in
the drop-down menu of GIS layers currently loaded into the map document. If it is not loaded into the
map document, the user may choose a parcel layer from ArcCatalog by selecting Choose Parcel Layer
from ArcCatalog. An ArcCatalog window will open in the GIS_Layers folder of the
ShorelineDirectory, where the user can select the parcel layer in one of the geodatabases. (This may take
a few moments depending on the complexity of the parcels layer.) If the user chooses not to use this
parcel layer, they may select another parcel layer. For further information on parcel layer requirements,
see “Parcel Layer” in the “Explanation of Input Data” section of appendix B). The tool will label the
parcels in the map document with the values in the PARC_NUMBER field of the parcel layer. The user
selects Done when the selections in the Define Input GIS Layers dialog box are completed.
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After successfully defining the input GIS layers, the Select Stage, Parcels, and Habitats for this
scenario button will be highlighted, indicating that the user should click this button next, after which
the Stage, Parcels, and Habitat Selection dialog box will open. Near the bottom of the dialog box is the
“CURRENT PARCEL GROUP SETTINGS” list box, which will display the options and values entered
by the user as they complete their selections. When the Stage, Parcels, and Habitat Selection dialog box
first opens, the top two buttons will be highlighted in yellow (fig. A5). The user must choose in which
mode to run the Shoreline Management Tool by selecting either Stage for Single-Time Scenario or
Time-Series Scenario buttons. If the Stage for Single-Time Scenario is selected, then the user may
define multiple groups of parcels for the scenario and specify one independent surface-water stage for
use with each group of parcels. If the Time-Series Scenario is selected, then the user may define only
one group of parcels for the scenario, but may specify a data file of date/time values and corresponding
surface-water stage values that will be used to run the scenario using each value of stage for the parcel
group. Both options allow the user to define multiple habitats for use with each parcel group.

Figure A5. Screen capture showing the Shoreline Management Tool, Stage, Parcels, and Habitat Selection dialog
box.
For the Single-Time Scenario option, the user must enter a surface-water stage for use with the first
parcel group by either typing the stage in the Stage for Single-Time Scenario text box or by using the
dropdown menu to select a stage. For the Time-Series Scenario option, the user is required to select the
Time-Series Scenario button that will open a Windows Explorer window and specify a file of date/time
and stage values for use with the parcel group (See section “Rules for Creating Time-Series Files” in
appendix A). After entering the surface-water stage value for the Single-Time Scenario or the data file
of surface-water stages for the Time-Series Scenario, the Set vertical datum for scenario: button is
highlighted, indicating that the user must choose a vertical datum for the scenario from the dropdown
list. The contents of the dropdown list is determined by the presence of either (or both) the NAVD88
and NGVD29 geodatabases. The Upper Klamath Lake Vertical Datum (UKLVD), a local vertical datum
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described in the section “Digital Elevation Model for the Lower Wood River Valley,” will be accessible
for the example for the lower Wood River Valley if the NGVD29 geodatabase is present. There can be
only one vertical datum per Single-Time or Time-Series scenario. For the example implementation for
the lower Wood River Valley the NAVD88 and NGVD29 vertical datums appear. UKLVD will appear
as an option if the file geodatabase for the NGVD29 is present.
After selecting a vertical datum, click Done with stage. After selecting the stage and vertical
datum, the Select parcels for Current Parcel Group button will be highlighted (fig. A6). Click this
button to select parcels for the current parcel group. The dialog box will minimize to better reveal the
ArcMap map window, and the ArcMap feature selection tool will be activated. Select the parcels for the
current group, then maximize the Stage, Parcels and Habitat Selection dialog box by clicking the
ArcMap icon on the Windows taskbar or by clicking the icon for the Shoreline Management Tool
button, then clicking Done with parcels. Each group of parcels must contain one or more parcels. Once
a parcel has been selected for a group, it may not be included in another group. This prevents the
potential conflict of specifying different stages for the same parcel within a single scenario, and also
prevents the same area being accounted for more than once, which may result in misleading estimates of
water or habitat parameter totals.

Figure A6. Screen capture showing the Shoreline Management Tool dialog box for selecting parcels.
After the group of parcels has been selected, the Habitat Name text box and the Load existing
habitat button will be highlighted (fig. A7). Habitats are optional and can be skipped by clicking the
Skip habitats button. Habitats are defined using the Habitat Name text box to specify a name
(required) and, optionally, using the Min Depth, in feet; Max Depth, in feet; Min Percent Slope;
Max Percent Slope; Min Aspect; or Max Aspect text boxes to indicate desired values of water depth,
percent slope, and aspect. Additionally, the check box for Include flat areas in aspect (located to the
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right of the aspect text boxes) also may be specified. See section “Rules for Defining Habitats.” Note,
that habitat depth is not an elevation (such as NAVD88 or NGVD29), but is rather the distance in feet
below the stage (positive values) or the distance in feet above the stage (negative values). The Save
defined habitat button is then used to immediately save the habitat definition to the
ShorelineDirectory\Habitat_Definitions folder.
If habitats have been previously defined, the existing habitat definitions may be loaded using the
Load existing habitat button that will open a Windows Explorer window in the
ShorelineDirectory\Habitat_Definitions folder allowing the user to select a habitat file.
The Delete current habitat button can be used to clear all habitat settings entered manually by the
user or through loading an existing habitat.
If a habitat is saved or loaded, the Add habitat to Current Parcel Group button will be
highlighted so that the user can add the habitat to the “CURRENT PARCEL GROUP SETTINGS” list
box. To add the defined or loaded habitat to the parcel group click the Add habitat to Current Parcel
Group button (fig. A8). Users may define or load more habitats, or click the Done with habitats
button.

Figure A7. Screen capture showing Shoreline Management Tool, define habitats or load an existing habitat.
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Figure A8. Screen capture showing Shoreline Management Tool, add defined or loaded habitat to parcel group.
The user may review the current parcel group settings shown in the “CURRENT PARCEL GROUP
SETTINGS” list box below the habitat section. Changes to the current group settings can be made by
clicking any of the following: Change parcel selection in Current Parcel Group button, Delete all
habitats from Current Parcel Group button, or Delete Current Parcel Group Settings button. Users
have the option to use the Delete Current Parcel Group Settings button to restart the group settings.
Select the check box labeled Save intermediate rasters of depth, slope, aspect, and habitats to
preserve these datasets after processing. All intermediate rasters are saved in a folder named
“IntermediateRasters_ParcelGroupN” (where N is the parcel group number) in the output folder named
by the user within the ShorelineDirectory\Output_Scenario_Workspaces. The depth rasters will be
automatically loaded into the map document though the remaining rasters must be manually loaded into
the map document if desired by the user. The intermediate rasters can be used to determine the extent to
which a particular habitat criterion is constraining the results, however, preserving these rasters will
require additional disk space.
After selecting a group of parcels, setting the stage, and defining (or skipping) the habitats, users
may click the Finalize Current Parcel Group Settings button (fig. A9). The current group settings are
then moved to the “SUMMARY OF ALL PARCEL GROUPS” list box at the bottom of the dialog box.
Once a group has been finalized, the only way to delete the group is to select it in the “SUMMARY OF
ALL PARCEL GROUPS” list box and click the Delete selected group button.
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Figure A9. Screen capture showing Shoreline Management Tool, finalize group settings.
At this point, if the Single-Time Scenario option was selected, the user may expand the scenario to
include additional groups of parcels and habitat definitions by selecting the Stage for Single-Time
Scenario button, then entering a surface-water stage for use with the next group of parcels, or they may
finish by clicking Exit Stage, Parcels, and Habitat Selection button (fig. A10). If the Time-Series
Scenario option was selected, the user must choose Exit Stage, Parcels, and Habitat Selection because
only one group of parcels is permitted with the Time-Series Scenario.
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Figure A10. Screen capture showing Shoreline Management Tool, create another group of parcels or exit parcel
selection.
After exiting the Stage, Parcels, and Habitat Selection dialog box, the Scenario Settings dialog box
will reopen. The Save current scenario definition to file text box will be highlighted as an indication
for the user to enter a filename for the scenario definition. All scenario definition filenames must consist
of alphanumeric characters only (except underscore), no spaces allowed, and must begin with a letter.
The Save Current Scenario button will save a text file with a prefix of “scn_” and a suffix of “.txt” in
the ShorelineDirectory\Scenario_Definitions folder (fig. A11).
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Figure A11. Screen capture showing the Shoreline Management Tool, save current scenario.
After saving the scenario definition, the Create output folder text box will be highlighted. The
user must specify a folder name and click the Create output folder button (fig. A12). All output folder
names must consist of alphanumeric characters only (except underscore), no spaces allowed, and must
begin with a letter.
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Figure A12. Screen capture showing the Shoreline Management Tool create output folder.
Selecting the Run Scenario button initiates the following actions:
1. the data are processed using all input scenario settings,
2. output products are created and placed in the designated output folder,
3. the ArcMap map document is populated with the output layers,
4. the map document is saved in the designated output workspace, and
5. the Shoreline Management Tool is closed.
A comment field in the lower left corner of the Scenario Settings dialog box informs users of the status
of the scenario being run. When the scenario has finished running, the user will receive a message from
the Shoreline Management Tool that the tool is closing (fig. A13). A file named
OutputMessagesFromScenarioRun.txt, which may contain informational or error messages that
occurred during the tool operation and the date and time when the tool started and finished running, is
created and stored in the designated output folder.
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Figure A13. Screen capture showing the Shoreline Management Tool, scenario completed.
Users may run multiple scenarios within one ArcMap session, but each scenario run must be saved
to a new map document. After a scenario has completed, another scenario may be run by selecting the
“File” menu from the main toolbar of ArcMap, then selecting “New.” This will close the current map
document, which the tool has already saved in the output workspace that was designated, and an empty,
new map document will be presented. Click the icon for the Shoreline Management Tool button to run
another scenario.

Detailed Output ArcMap Map Document Description
The output GIS file created for either the Single-Time Scenario or Time-Series Scenario is an
ArcMap, version 10, map document with the filename MapDocument.mxd. The map document varies
slightly depending on which scenario, Single-Time or Time-Series, was selected by the user. Example
screen images of the map document for an implementation of a Time-Series Scenario for the lower
Wood River Valley are provided in figures A14–A17.
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Figure A14. Screen capture showing an ArcMap map document for Time-Series Scenario showing inundation
layers for selected parcels.

Figure A15. Screen capture showing an ArcMap map document for Time-Series Scenario showing water depth
layers for selected parcels.
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Figure A16. Screen capture showing an ArcMap map document for Time-Series Scenario showing habitat layers
for selected parcels.

Figure A17. Screen capture showing an ArcMap map document for Time-Series Scenario showing habitat layers
overlaid on to water depth layers for selected parcels.
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For the Single-Time Scenario, a layer group is created in the map document for each parcel group
specified by the user with the naming convention of “Parcel Group i,” where i is the ith parcel group
defined by the user during the graphical user interface part of the Shoreline Management Tool. The ith
parcel group can be determined from the order in which the parcel groups were entered and can be
viewed in the Input_Data_Summary.txt file in the output workspace.
For the Time-Series Scenario, a layer group is created in the ArcMap map document for each
date/time record in the time-series file with the naming convention of “Date/Time:
YYYYMMDDhhmm,” where YYYYMMDDhhmm is the date/time associated with each record of the
Time-Series Scenario input file (see “Rules for Creating Time-Series files” in appendix A for format
information). Note that for space and time considerations, only the first 12 records of the time-series
input file are loaded into the map document. If output layers from additional time-series records are
desired, they may be loaded using the ArcMap Add Data button on the toolbar and browsing to the
directory where the output data layers are stored.
The map document will contain the parcels layer described as follows:
Parcels: File geodatabase polygon FeatureClass layer of polygon boundaries of land areas
delineated and provided by the user to identify areas of interest that includes a field
named PARC_NUMBER that contains unique integer IDs for each parcel. The tool
labels the parcels in the map document with the values in the PARC_NUMBER field.
Each layer group in either the Single-Time or Time-Series Scenario map document will contain the GIS
layers described as follows:
Inundation: Contains file geodatabase polygon FeatureClass layers for each parcel consisting of
polygons of inundated areas on the basis of the user-specified stage elevation (fig. A14).
These FeatureClass layers have the naming convention of p<*>_<stage>_inundation,
where “*” is the parcel number. Note that <stage> does not have a decimal point, for
example the stage of 4138.80 is listed as 413880 in the layer name.
The output map document also may contain the following layers, if optionally specified by the user
while running the graphical user interface part of the Shoreline Management Tool (see section “Detailed
Tool Operation Instructions”):
Habitat: Contains polygon shapefiles by parcel and habitat consisting of areas that met all habitat
criteria defined by the user with regard to depth, slope, and aspect at the user-specified
stage elevation (fig. A15). These shapefiles have the naming convention
p<*>_<stage>_habitat_<name of habitat>.shp, where “*” is the parcel number. Note that
in the raster to polygon conversion, a group of contiguous raster cells (cells that share a
common edge or side) is converted to a common polygon. Raster cells that share only a
common corner (corner-touching cells) are converted to individual polygons. The sum
area of all polygons will be identical to the sum area of all raster cells. The total number
of polygons generated is dependent on the resolution of the DEM raster as specified by
the grid-cell size. A 1-m resolution DEM will generate more polygons than a 5-m DEM.
Note that owing to limitations in the Environmental symbology style reference, if more
than nine habitats are specified within a scenario, the symbology used for the ninth
habitat specified during input to the graphical user interface will be used for all
subsequent habitats.
Water Depth: Contains rasters for each parcel consisting of values of water depth (in feet) on the
basis of the user-specified surface-water stage (fig. A16). These rasters have the naming
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convention of p<*>dep<stage>, where “*” is the parcel number. Note that negative
values of water depth indicate height above the user-specified stage and represent dry
areas. The symbology used for the depth rasters uses hues of blue for inundated areas
with darker hues indicating greater depths below the user-specified stage. Dry areas are
shown in hues of brown with darker hues indicating greater height above the userspecified stage. The contact between the light blue and dark brown colors represents the
shoreline at the user-specified stage.
The following layers, if optionally specified by the user while running the graphical user interface part
of the Shoreline Management Tool (see section “Detailed Tool Operation Instructions”), are not loaded
automatically into the output map document and must be loaded manually using “Add Data” under the
“File” menu or using the “Add Data” icon:
Depth Habitat: Contains rasters by parcel and habitat consisting of depth values (in feet) for cells
meeting the habitat criteria for depth and "NoData" elsewhere. The naming convention
used is p*_dep_hi, where * is the parcel number (without leading zeros) and i is the ith
habitat defined by the user during the graphical user interface part of the Shoreline
Management Tool. The ith habitat can be determined from the order in which the habitats
were entered and can be viewed in the Input_Data_Summary.txt file in the output
workspace.
Slope Habitat: Contains rasters by parcel and habitat consisting of slope values (in percent) for
those cells meeting the habitat criteria for slope and "NoData" elsewhere. The naming
convention used is p*_slp_hi, where * is the parcel number (without leading zeros) and i
is the ith habitat defined by the user during the graphical user interface part of the
Shoreline Management Tool. The ith habitat can be determined from the order in which
the habitats were entered and can be viewed in the Input_Data_Summary.txt file in the
output workspace.
Aspect Habitat: Contains rasters by parcel and habitat consisting of aspect values (in degrees
clockwise from north) for those cells meeting the habitat criteria for aspect and "NoData"
elsewhere. The naming convention used is p*_asp_hi, where * is the parcel number
(without leading zeros) and i is the ith habitat defined by the user during the graphical
user interface part of the Shoreline Management Tool. The ith habitat can be determined
from the order in which the habitats were entered and can be viewed in the
Input_Data_Summary.txt file in the output workspace.
Habitat: Contains rasters by parcel and habitat consisting of values of 1, 2, or 3 (representing the
total number of criteria that were specified by the user to define the habitat) for those
cells meeting all habitat criteria (depth, slope, and aspect) and "NoData" elsewhere. The
naming convention used is “p*_habi, where * is the parcel number (without leading
zeros) and i is the ith habitat defined by the user during the graphical user interface part
of the Shoreline Management Tool. The ith habitat can be determined from the order in
which the habitats were entered and can be viewed in the Input_Data_Summary.txt file in
the output workspace

Detailed Excel Workbook Operation Instructions
In this section of the manual, Excel workbooks are identified with bold text and Excel worksheets
within the workbooks with italic text. Depending on the mode selected by the user to run the Shoreline
Management Tool, Single-Time Scenario or Time-Series Scenario, the Excel workbook created at the
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completion of the ArcMap graphical user interface part of the Shoreline Management Tool will be
named either SingleTime.xlsm or TimeSeries.xlsm, respectively. The instructions to run each
workbook are identical. The Excel workbook will be located in the scenario output directory specified
by the user. Note that the file extension for the workbooks is “.xlsm” and that the Excel file icon in the
folder associated with the file will have an exclamation point next to it indicating that the workbook is a
macro-enabled workbook. These workbooks contain Visual Basic for Applications (VBA) macros. The
macros must be enabled in Excel for them to run (see Excel Help for more information).
In the worksheet Start, a button will appear labeled as “Load and Run Single-Time Scenario” or
“Load and Run Time-Series Scenario” depending on the option selected by the user when running the
Shoreline Management Tool. Click this button to run the VBA macro that will use the results from the
graphical user interface part of the tool to perform additional functions such as data table creation,
calculation of summary statistics, and construction of graphs. If the workbook has been modified since
being opened or if the macro has been previously run, a warning message will appear indicating that the
macro has detected existing worksheets within the Excel workbook that will be deleted if processing is
continued, and provides an option to abort the procedure to prevent loss of existing data. The macro will
search for the output files from the graphical user interface part of the tool in the folder
TextfilesForSpreadsheet. If the files are not located, a pop-up box will open allowing the user to browse
to the folder containing the output files.
During processing, the macro will create several worksheets and populate each with various types
of data. When the macro is complete, a pop-up box will open indicating “Processing Complete,” and the
user should click “OK.” The macro will report the times of the “Last Run Start” and “Last Run Stop”
and show the elapsed time. To ensure against data loss from subsequent running of the Load Scenario
macro the user may save the workbook using “Save As” from the File menu and selecting “Save as
type: Excel Workbook (*.xlsx)” and confirming the selection to save a macro-free workbook.
Owing to limitations of Excel, dates prior to January 1, 1900 (January 1, 1904, for Excel for Mac),
may not be formatted as expected, and may produce unexpected results in the data tables and graphs.

Detailed Excel Worksheet Output Description
The Excel workbooks, SingleTime.xlsm or TimeSeries.xlsm, depending on the mode selected by
the user, contain the data tables of the water parameters and habitat parameters at the successful
completion of the macro to load and run the results from the graphical user interface part of the
Shoreline Management Tool. A general description of the contents of the worksheets is provided below
followed by more complete details for each worksheet and images of an example of each worksheet.
The water parameters are presented by:
1. total (total of all parcels in all parcel groups),
2. parcel groups (total of all parcels in each parcel group), and
3. individual parcels.
The water parameters at the user-specified input stage elevation consist of mean depth, inundated
area, dry area, percent of total area inundated, and inundated volume. Note that mean depth is calculated
as the inundated volume divided by the inundated area. Values of mean depth for parcel groups and for
total (all parcels in all parcel groups) are calculated as a weighted mean by inundated area of each
parcel. Additionally, note that the water parameters apply to the inundated area of the parcel on the basis
of the water depth from the user-specified stage and do not correspond to the areas having additional
specified habitat criteria that include slope or aspect.
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The habitat parameters are presented by:
1.
2.
3.
4.

parcel group, parcel, and habitat (individual habitats for each parcel in each parcel group);
parcel group and habitat (totals for individual habitats of all parcels in each parcel group);
individual habitat (totals for individual habitats of all parcels in all parcel groups); and
parcel group (total of all habitats in all parcels of each parcel group).
The habitat parameters for areas meeting all the specified habitat criteria, (including water depth,
slope, and aspect) include total number of polygons, total area of polygons, and total perimeter of
polygons. Note that the Shoreline Management Tool will produce output values that are not rounded
with respect to significant digits. Values in the Excel workbooks have been formatted to appear rounded
for esthetic purposes though the actual cell values are not rounded. The user is responsible for
determining the appropriate number of significant digits for these values on the basis of the accuracy
and precision of the input data.
The Single-Time Scenario workbook, SingleTime.xlsm, contains the following worksheets:
Introduction_SingleTime: Contains introductory information describing the purpose and source
of the workbook and the worksheets within.
Start: Contains the button to load and run the scenario and the date/time of when the macro was
last started and ended, and the elapsed time for the macro to complete processing (fig.
A18). The worksheet also will display two version numbers, one for the version number
of the Shoreline Management Tool spreadsheet that is currently being run and, once the
macro is run, the version number is shown that was used to create the input data (see
section “Version Numbers”). This may help to identify incompatibilities of older datasets
resulting from updates or changes in the data input format used by the spreadsheets.
Stage_Vol_Area_Depth_SUMMARY: Contains a summary of the water parameters values at the
user-specified stage by total (all parcels in all parcel groups), all parcels in individual
parcel groups, and by individual parcel. Columns include parcel group, parcel, userspecified input stage elevation, and values of mean depth, inundated area, dry area,
percent of total area inundated, and inundated volume at the user-specified input stage
(fig. A19). Note that percent of total area inundated is calculated as 100 multiplied by the
area of inundation at the user-specified stage divided by the area of inundation for the
maximum value of stage provided in the data tables (StageLookupNAVD88.txt and
StageLookupNGVD29.txt).
Habitat_Output_SUMMARY: Contains a summary of the values for areas meeting all habitat
criteria by individual habitats for each parcel in each parcel group, individual habitats for
all parcels in each parcel group, individual habitats for all parcels in all parcel groups,
and all habitats in all parcels for each parcel group. Columns include a description of the
habitat, parcel, and group to which the row information applies: parcel group, parcel,
habitat name, and values for total number of polygons, total area of polygons, and total
perimeter of polygons, for areas that meet all habitat criteria (fig. A20).
Input Data Summary: Contains a reference copy of the input data to the graphical user interface
part of the Shoreline Management Tool (fig. A21).
Output messages from Run: Contains a reference copy of the output messages from the graphical
user interface part of the Shoreline Management Tool (fig. A22).
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Figure A18. Screen capture showing the Single-Time Scenario workbook, SingleTime.xlsm, worksheet: Start.
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Figure A19. Screen capture showing example of Single-Time Scenario workbook, SingleTime.xlsm, worksheet:
Stage_Vol_Area_Depth_SUMMARY.
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Figure A20. Screen capture example of Single-Time Scenario workbook, SingleTime.xlsm, worksheet: Habitat_Output_SUMMARY.

Figure A21. Screen capture example of Single-Time Scenario workbook, SingleTime.xlsm, worksheet: Input Data Summary.
38

Figure A22. Screen capture example of Single-Time Scenario workbook, SingleTime.xlsm, worksheet: Output messages from run.

The Time-Series Scenario workbook, TimeSeries.xlsm, contains the following worksheets:
Introduction_TimeSeries: Contains introductory information describing the purpose and source
of the workbook and the worksheets within.
Start: Contains the button to load and run the scenario and the date/time of when the macro was
last started and ended, and the elapsed time for the macro to complete processing (similar
to worksheet for the Single-Time Scenario shown in figure A18). The worksheet also
will display two version numbers, one for the version number of the Shoreline
Management Tool spreadsheet that is currently being run and, once the macro is run, the
version number is shown that was used to create the input data (see section “Version
Numbers”). This may help to identify incompatibilities of older datasets resulting from
updates or changes in the data input format used by the spreadsheets.
Parcel * – Habitat: Where * is the parcel number. There is a worksheet for each parcel specified
in the parcel group for the Time-Series Scenario. For each date/time entry in the TimeSeries Scenario input file this worksheet contains the user-specified stage and calculated
values for areas meeting all habitat criteria. Columns include the user-specified date/time
(as an Excel date value) and the user-specified input stage elevation. Columns also are
presented for each habitat and include the total area of polygons, total perimeter of
polygons, and total number of polygons for areas that meet all habitat criteria for the
specified habitat. The final column contains the user-specified date/time (using the input
date/time format) (fig. A23). If the Upper Klamath Lake Vertical Datum (UKLVD) was
specified, then an additional column containing the NGVD29 equivalent surface-water
stage also is provided for comparison with the ArcMap map document, which in this
instance will use NGVD29 in the naming convention for inundation layers.
Parcel * - Water: Where * is the parcel number. There is a worksheet for each parcel specified
in the Time-Series Scenario. For each date/time entry in the Time-Series Scenario input
file this worksheet contains the user-specified stage and calculated values of the water
parameters. Columns include the user-specified date/time (as an Excel date value); userspecified input stage elevation; values of the inundated volume, inundated area, dry area,
and mean depth, at the user-specified input stage; and the user-specified date/time (using
the input date/time format) (Figure fig. A24). If UKLVD was specified as the vertical
datum, then an additional column containing the NGVD29 equivalent surface-water
stage also is provided for comparison with the ArcMap map document, which in this
instance will use NGVD29 in the naming convention for inundation layers.
All Parcels - Habitat: For each date/time entry in the Time-Series Scenario input file this
worksheet contains the user-specified stage and totals of the calculated values of the
habitat parameters for areas meeting all habitat criteria from all parcels specified in the
parcel group for the Time-Series Scenario by habitat. Columns include the user-specified
date/time (as an Excel date value) and user-specified input stage elevation. Columns also
are presented for each habitat and include the area of polygons, perimeter of polygons,
and number of polygons totaled for areas of all parcels that meet all habitat criteria for
the specified habitat. The final column contains the user-specified date/time (using the
input date/time format) (fig. A25).
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All Parcels - Water: For each date/time entry in the Time-Series Scenario input file this
worksheet contains the user-specified stage and totals of the water parameters for all
parcels specified in the parcel group for the Time-Series Scenario. Columns include the
user-specified date/time (as an Excel date value); user-specified input stage elevation;
values of the inundated volume, inundated area, and dry area at the user-specified input
stage totaled for all parcels; the mean depth calculated as a weighted mean using the
inundated volume and inundated area of each parcel; and the user-specified date/time
(using the input date/time format) for all parcels (fig. A26).
Charts: Contains graphs of user-specified stage vs. time; habitat area vs. time for each parcel by
habitat, as well as totaled for all parcels by habitat; inundated volume vs. time for each
parcel, as well as totaled for all parcels; inundated area vs. time for each parcel, as well
as totaled for all parcels; dry area vs. time for each parcel, as well as totaled for all
parcels; and mean depth vs. time for each parcel, as well as the weighted mean for all
parcels (fig. A27).
Input Data Summary: Contains a reference copy of the input data to the graphical user interface
part of the Shoreline Management Tool (fig. A28).
Output messages from run: Contains a reference copy of the output messages from the graphical
user interface part of the Shoreline Management Tool (fig. A29).
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Figure A23. Screen capture showing example of Time-Series Scenario workbook, TimeSeries.xlsm, worksheet: Parcel * – Habitat.

Figure A24. Screen capture showing example of Time-Series Scenario workbook, TimeSeries.xlsm, worksheet: Parcel * - Water.
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Figure A25. Screen capture showing example of Time-Series Scenario workbook, TimeSeries.xlsm, worksheet: All Parcels - Habitat.

Figure A26. Screen capture showing example of Time-Series Scenario workbook, TimeSeries.xlsm, worksheet: All Parcels - Water.
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Figure A27. Screen capture showing example of Time-Series Scenario workbook, TimeSeries.xlsm, worksheet: Charts.
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Figure A28. Screen capture showing example of Time-Series Scenario workbook, TimeSeries.xlsm, worksheet: Input Data Summary.
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Figure A29. Screen capture showing example of Time-Series Scenario workbook, TimeSeries.xlsm, worksheet: Output messages from run.

Contents of ShorelineDirectory
The ShorelineDirectory contains seven folders as listed in the following sections. Removing or
modifying folder names or contents will result in errors during Shoreline Management Tool operation.

GIS_Layers Folder
This folder is intended to contain the rasters of elevation, slope, and aspect created from the DEMs
for each land parcel. The GIS_Layers folder provided with the generic version of the Shoreline
Management Tool intended for general use contains no files. The description of the GIS_Layers folder
presented here is specific to the lower Wood River Valley example. Implementation for other study
areas requires that the rasters be created by the user following the example described here. The use of
DEM data consisting of high resolution LiDAR data is not a requirement; however, the naming
conventions used here must be adhered to.
The GIS_Layers folder for the example implementation contains rasters of DEMs of elevation,
slope, and aspect derived from LiDAR data for each parcel of the lower Wood River Valley study area
at horizontal resolutions of 1 and 5 m. The naming convention of the DEM rasters is
p*_<res>mdem<vertical datum>, where * is the parcel number (without leading zeros), <res> is the
resolution of the DEM in meters (for the lower Wood River Valley either 1 or 5 is used to represent 1 m
or 5 m), and <vertical datum> is either 29 or 88 for NGVD29 or NAVD88. Also included for each
parcel, are rasters of slope and aspect. The naming conventions for the slope and aspect rasters are
p*_<res>mslp and p*_<res>masp, respectively, where * is the parcel number (without leading zeros),
<res> is the resolution of the raster in meters.
All rasters are in ArcInfo grid format. Because of length restrictions for the names of ArcInfo grid
files (limited to 13 characters), if the total number of digits used to represent the parcel number and the
DEM resolution exceeds 5 digits then some grid names may be truncated and could result in errors
during Shoreline Management Tool operation.

Habitat_Definitions Folder
This folder contains habitat definition text files created by the user. The Habitat_Definitions folder
provided with the generic version of the Shoreline Management Tool intended for general use initially
contains no files. Habitat definition files are added to the folder when specified during the use of the
Shoreline Management Tool. Files that have been previously created may be copied from other folders.
Minor modifications to the habitat definition files using a file editor are possible but not recommended
because of the potential for corrupting the expected information format that may cause the program to
crash or may cause unpredictable behavior. All habitat definition files in this folder can be accessed
while running the tool. The habitat definitions folder for the implementation for the lower Wood River
Valley contains several example habitat definition files used to develop some of the figures.
The naming convention for the habitat definitions files is hab_<habitat_name>.txt. The habitat
name should consist of alphanumeric characters with no spaces. The only special character allowed is an
underscore. The name must start with a letter, not a number or an underscore. The Shoreline
Management Tool will automatically add the prefix of "hab_" and the suffix of ".txt" to the userspecified habitat filename.
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Rules for Defining Habitats

1. All habitats must have a name only consisting of alphanumeric characters (except underscore), no
spaces allowed, and the name must begin with a letter.
2. All habitats must be defined using one or more of the following criteria: depth, slope, or aspect.
3. Depth values are assigned as feet below the user-specified surface-water stage. Note that users
wishing to specify habitats using elevation values must first convert to values of depth by
subtraction of the elevation value from the user-specified surface-water stage. Depth may be
specified as either a minimum (specify minimum only), a maximum (specify maximum only), a
range (specify the minimum and maximum, inclusive), or as an exact value (specify minimum =
maximum). If both minimum and maximum values of depth are specified, the minimum depth must
be less than or equal to the maximum depth. Positive values of depth may be used to define aquatic
habitats that are completely below the user-specified surface-water stage (minimum and maximum
depth ≥ 0), and are therefore inundated. Negative values of depth may be used to define terrestrial
habitats that are completely above the user-specified surface-water stage (minimum and maximum
depth ≤ 0), and are therefore dry. A negative minimum and a positive maximum value of depth may
be used to define habitats that encompass the shoreline and include aquatic and terrestrial habitat
components (minimum depth ≤0 and maximum depth ≥ 0).
4. Slope values are in percent and must be greater than or equal to 0. Slope may be specified as either a
minimum (specify minimum only), a maximum (specify maximum only), a range (specify the
minimum and maximum, inclusive), or as an exact value (specify minimum = maximum). If both
minimum and maximum values of slope are specified the minimum slope must be less than or equal
to the maximum slope. Note that the use of Include flat areas in aspect check box in combination
with a slope criterion greater than 0 percent will result in a null dataset because, by definition, flat
areas have a slope of 0 percent.
5. Aspect values are in degrees clockwise from north and must be greater than or equal to 0 and less
than or equal to 360 degrees. They must be entered in clockwise order where 0 or 360 degrees are
north, 90 degrees is east, 180 degrees is south, and 270 degrees is west. For example, to specify an
aspect of northwest to northeast, enter a minimum aspect of 315 degrees and a maximum aspect of
45 degrees. Aspect may be specified as either a minimum (specify minimum only), a maximum
(specify maximum only), a range (specify the minimum and maximum, inclusive), or as an exact
value (specify minimum = maximum). The user may specify areas that are perfectly horizontal
(flat), either in combination with the aspect text boxes or independently, by checking the check box
for Include flat areas in aspect. Flat areas in the aspect grid are required to be assigned as negative
values. The Aspect tool under Spatial Analyst Tools in the ArcToolbox of ArcMap assigns flat areas
as -1. Grids created by other software programs may assign different values of aspect to represent
flat areas such as 0, -1, -9999, or some other value, and may require modification before use with the
Include flat areas in aspect check box feature. Note that the use of Include flat areas in aspect
check box in combination with a slope criterion greater than 0 percent will result in a null dataset
because, by definition, flat areas have a slope of 0 percent.
6. Note that the Skip habitats button can be selected so that no criteria are used to constrain the area of
the parcel(s) used in the analysis. The entire area of the parcel(s) will be used to obtain output results
consisting of water depth, inundated area, and volume.
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Output_Scenario_Workspaces Folder
This folder contains the output folders and files (described below) for each run of the Shoreline
Management Tool using the output name as specified by the user during the “Create output folder” step
of the graphical user interface. These output folders and files contain the products produced by the tool,
and include the folders named HabitatShapefiles, IntermediateRasters, TextfilesForSpreadsheet, that
contains the habitat shapefiles and other layers that may have been specified by the user, such as
inundation layers or depth rasters that were created or loaded during Tool operation. The
Output_Scenario_Workspaces folder provided with the generic version of the Shoreline Management
Tool intended for general use initially contains no files. Output folders are added at the completion of a
Shoreline Management Tool run. The Output_Scenario_Workspaces folder for the implementation for
the lower Wood River Valley contain several example output folders used to develop some of the
figures.
The HabitatShapefiles folder contains polygon shapefiles for the habitats specified by the user. The
shapefiles have the naming convention of p<*>_<stage>_habitat_<name of habitat>.shp, where “*” is
the parcel number.
The IntermediateRasters folders are organized by parcel group or by time-series date/time and will
be created only if the user selected to save the depth and habitat rasters during the graphical user
interface part of the tool. Because of name length restrictions on rasters created in ArcMap, the names
of the intermediate rasters are abbreviated using the convention of p<*>_<asp for aspect, dep for depth,
or slp for slope>_h<habitat number>, where “*” is the parcel number. The habitats are numbered in the
order in which they were entered into the tool. The order in which the habitats were entered can be
viewed in the Input_Data_Summary.txt file in the output workspace. These intermediate depth, slope,
and aspect rasters represent the areas for which the depth, slope, and aspect criteria were met for the
respective habitat. The depth raster for the entire parcel is named p<*>dep<stage>, where “*” is the
parcel number. The habitat raster for the parcel is named p<*>_hab<habitat number>, where “*” is the
parcel number.
The TextfilesForSpreadsheet folder contains numerous text files created by the tool that are read by
the Excel workbooks. The details in the text files are not particularly useful for the user who will find
the same information in the Excel workbooks easier to understand.
Informational text files in the Output_Scenario_Workspaces folder include a scenario description
(scn_<scenario_name>.txt), a user input summary (Input_Data_Summary.txt), and the output messages
(OutputMessagesFromScenarioRun.txt) from the tool. The OutputMessagesFromScenarioRun.txt file
will contain informational or error messages that might have occurred during the tool operation and
contain the date and time when the tool started and finished running.
Other files in the Output_Scenario_Workspaces folder include the ArcMap map document
(MapDocument.mxd) containing the results from the tool, an Excel spreadsheet (either SingleTime.xlsm
or TimeSeries.xlsm depending on the scenario selected by the user), and, if the Time-Series Scenario
was selected, the time-series file that was used..

Processed_Data Folder
This folder contains the geodatabase consisting of parcels, inundation areas, and the stage-volumearea relationship tables for the area of interest. The Processed_Data folder provided with the generic
version of the Shoreline Management Tool intended for general use contains no files. The description of
the Processed_Data folder presented here is specific to the lower Wood River Valley example.
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Implementation for other study areas requires that the geodatabase be created by the user following the
example described here and the instructions provided in Appendix B. Preparation of Input Data for use
with the Shoreline Management Tool.
The Processed_Data folder contains an ArcMap version 10 file geodatabase for vertical datum of
NAVD88 or NGVD29. Both of the geodatabases have the same map projection (UTM, Zone 10,
NAD83, units meters) differing only in the vertical datum. The geodatabases are for use with the
example for the lower Wood River Valley, Oregon. The geodatabases must be created by the user for
use with other areas. These geodatabases contain the parcels, inundation areas, and the stage-volumearea relationship tables. There is no elevation component associated the parcel layer; either geodatabase
can be the source for the parcel layer in the map document. The Processed_Data folder also contains an
xml file of Federal Geographic Data Committee (FGDC) compliant metadata for the geodatabase for the
lower Wood River Valley.
Contents and Naming Conventions of the Data in the File Geodatabases

1. File geodatabases: ShorelineManagementTool_<vertical datum>.gdb, where <vertical datum is
either NAVD88 or NGVD29.
2. Tables containing the stage-volume-area lookup values by parcel inside the file geodatabase:
parc_*_<vertical datum>, where * is the parcel number from the Parcels FeatureClass field named
PARC_NUMBER (without leading zeros) and <vertical datum> is either 88 or 29 for NAVD88 or
NGVD29. Records in the tables contain stage at 0.01 feet intervals and associated volume in cubic
meters and area in square meters, as well as volume in acre-feet and area in acres. The equivalent
UKLVD stage is provided for each record in the NGVD29 tables.
3. FeatureDatasets inside the file geodatabases for each parcel consisting of polygons outlining
inundated areas: InundationAreasParcel_*, where * is the parcel number from the Parcels
FeatureClass field named PARC_NUMBER (without leading zeros). The InundationAreasParcel_*
FeatureDatasets contain inundation polygons for the parcel (without leading zeros) after which the
FeatureDataset is named (for example, InundationAreasParcel_10 contain the inundation polygons
for parcel number 10).
4. FeatureClasses inside the FeatureDatasets for each stage consisting of the polygons outlining
inundated areas: p*<stage>_polygon, where * is the parcel number from the Parcels FeatureClass
field named PARC_NUMBER (without leading zeros), and <stage> is the surface-water stage in
feet typically ranging from 4135.30 to 4176.30 ft for the example of the lower Wood River Valley,
at intervals of 0.1 ft. The <stage> does not contain the decimal point which designates stage at 0.01
ft. (for example, for parcel 10 at stage 4138.80 ft, the inundation polygon FeatureClass name is
p10413880_polygon). When these layers are added to the ArcMap map document they use the same
naming convention except that “polygon” is replaced by “Inundation.”
5. Parcels FeatureClass inside the file geodatabase consisting of the polygons of the land areas for each
parcel: The Parcels FeatureClass must be loaded into ArcMap for the tool to operate. The tool will
allow the user to load the default parcel layer from the NAVD88 geodatabase, or the user can choose
to load an alternative parcel layer. Whichever parcel layer the user decides to use, there must be
associated DEM, slope, and aspect rasters for each parcel. The Parcels FeatureClass currently has 34
parcels for an area covered by LiDAR for the example implementation for the lower Wood River
Valley, Oregon.
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Scenario_Definitions Folder
This folder contains scenario definition text files created by the user. The Scenario_Definitions
folder provided with the generic version of the Shoreline Management Tool intended for general use
initially contains no files. Scenario definition files are added to the folder when specified during the use
of the Shoreline Management Tool. Files that have been previously created may be copied from other
folders. Minor modifications to the scenario definition files using a file editor are possible but not
recommended because of the potential for corrupting the expected information format that may cause
the program to crash or may cause unpredictable behavior. All scenario definition files in this folder can
be accessed while running the tool. The scenario definitions folder for the implementation for the lower
Wood River Valley contain several example scenario definition files used to develop some of the
figures.
The naming convention of the scenario definition files is scn_<scenario_name>.txt. The scenario
name should consist of alphanumeric characters with no spaces. The only special character allowed is an
underscore. The name must start with a letter, not a number or an underscore.

Time-Series_Files Folder
This folder holds time-series input files for use with the Time-Series Scenario option. The TimeSeries_Files folder provided with the generic version of the Shoreline Management Tool intended for
general use initially contains no files. The files must be created by the user in the format specified by the
rules for creating time-series files. If the Time-Series Scenario is selected and a time-series file other
than those located in the Time-Series_Files folder used, then the time-series file will be copied into the
\ShorelineDirectory\Output_Scenario_Workspaces\ in the output folder specified by the user during the
“Create output folder” step of the graphical user interface. Files that have been previously created may
be copied from other folders. All Time-Series input files in the Time-Series_Files folder can be accessed
while running the tool. The Time-Series_Files folder for the implementation for the lower Wood River
Valley contain several example Time-Series input files used to develop some of the figures.
Rules for Creating Time-Series Files

1. Time-series files must be comma delimited text files that may be created using a text editor.
2. The file must contain one line for each record beginning with the time, followed by a comma, and
then the surface-water stage.
3. The time must be in the format of YYYYMMDDhhmm, where YYYY is the year, MM is the
month, DD is the day, hh is the hour (use military time), and mm is the minute. Leading zeros must
be retained for months, days, hours, or minutes with values less than 10.
4. Owing to limitations within Excel, dates prior to January 1, 1900, may not appear formatted as
expected in the output Excel Workbook, and may produce unexpected results in the data tables and
graphs.
5. The surface-water stage must be in feet and must be within the elevation ranges defined in the
ShorelineDirectory\Tool_Source_Files\tool_parameters.txt file (see section “Detailed Installation
Instructions”).
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6. As an example, a time-series file for September 2, 2011, with a surface-water stage of 4138.80 ft at
8:00am, a stage of 4139.80 ft at 10:00am, and a stage of 4140.20 ft at 12:00pm, will look like this:
201109020800,4138.80
201109021000,4139.80
201109021200,4140.20

Tool_Source_Files Folder
This folder holds the source files necessary to run the Shoreline Management Tool, which are
described below. Do not delete or modify any of the folder contents except as instructed for preparation
of input data. Files that have been previously created may be copied from other folders. All source files
in the Tool_Source_Files folder can be accessed while running the tool.
The Tool_Source_Files folder provided with the generic version of the Shoreline Management Tool
intended for general contains several files that are listed here. It is important to note that several
additional files must be created by the user prior to using the tool (see “Detailed Installation
Instructions” in Appendix A and “Data Tables” in Appendix B).
ShorelineAddin_v20130123.esriAddIn: Required ArcMap Add-in file created using the Visual
Basic .NET (VB.NET) programming language that contains the computer code for the
Shoreline Management Tool within a single compressed file (see “Detailed Installation
Instructions). The program consists of a graphical user interface developed for ArcMap
to accept user input, process data, and prepare output results to be displayed in ArcMap
or to be further processed using the provided Excel files.
Shoreline_Mgmt_Tool_Users_Guide_v20130123.pdf: Required Adobe PDF file containing a
version of the User’s Guide that can be accessed from the Shoreline Management Tool
using the “Introduction and Instructions” button and selecting “User’s Guide.” This file
should not be deleted or modified.
SingleTime.xlsm: Required Excel file used to process the results for SingleTime scenarios from
the graphical user interface part of the Shoreline Management Tool and is copied into
each output workspace as it is created. See section “Detailed Excel Worksheet Output
Description” for information on this file. This file should not be deleted or modified.
TimeSeries.xlsm: A required Excel file used to process the results for TimeSeries scenarios from
the graphical user interface part of the Shoreline Management Tool and is copied into
each output workspace as it is created. See section “Detailed Excel Worksheet Output
Description” for information on this file. This file should not be deleted or modified.
The Tool_Source_Files folder for the implementation for the lower Wood River Valley contains all
the necessary source files to run the tool. These includes the files listed above that are provided with the
generic version of the tool and the following files listed here.
tool_parameters.txt: Required text file that is a user-generated input file to the Shoreline
Management Tool. A version of this file for use with the lower Wood River Valley
example is provided. Implementation for other study areas requires that this file be
modified or created by the user. See section “Detailed Installation Instructions” for a
description of this file.
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StageLookupNAVD88.txt: Required text file used by the spreadsheet part of the Shoreline
Management Tool to look up volume and area values for each land parcel on the basis of
the land-surface elevation using the NAVD88 vertical datum. A version of this file for
use with the lower Wood River Valley example created using a 1-m resolution DEM is
provided. Implementation for other study areas requires that this file be modified or
created by the user. See section “Data Tables” in appendix B for information on this file.
StageLookupNGVD29.txt: Required text file used by the spreadsheet part of the Shoreline
Management Tool to look up volume and area values for each land parcel on the basis of
the land-surface elevation using the NGVD29 vertical datum. A version of this file for
use with the lower Wood River Valley example created using a 1-m resolution DEM is
provided. Implementation for other study areas requires that this file be modified or
created by the user. See section “Data Tables” in appendix B for information on this file.
lower_Wood_River_Valley_Stage_Vol_Area_Lookups.xlsx: This is an optional Excel file that
is included with the example for the lower Wood River Valley, Oregon. This workbook
contains stage/volume, stage/area, and stage/mean depth lookup tables for the lower
Wood River Valley created using a 1-m resolution DEM. Also included are charts for
each of the three vertical datums commonly in use in this area: NAVD88, NGVD29, and
UKLVD. These data are provided as part of the example implementation of the Shoreline
Management Tool. This file is not required for use with the Shoreline Management Tool.
Additional information about this file is available in the “Introduction” worksheet within
the file.
USGS_OFR2012_1247_Table_C1.xlsx: This is an optional Excel file that is included with the
example for the lower Wood River Valley. This workbook contains summary statistics of
land-surface elevations from LiDAR for land parcels delineated for the lower Wood
River Valley, Oregon, created using a 1-m resolution DEM for three vertical datums:
North American Vertical Datum of 1988 (NAVD88), National Geodetic Vertical Datum
of 1929 (NGVD29), and Upper Klamath Lake Vertical Datum (UKLVD), as presented in
Table C1 of this report. These data are provided as part of the example implementation of
the Shoreline Management Tool. This file is not required for use with the Shoreline
Management Tool. Additional information about this file is available in the
“Introduction” worksheet within the file.
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Explanation of Input Data
Data for use with the Shoreline Management Tool must conform to certain standards. Provided
below are explanations for preparation of each of the input datasets required for use with the tool.

Parcel Layer
The Shoreline Management Tool requires a file geodatabase that must contain a polygon
FeatureClass named “Parcels.” The Parcels attribute table must contain a field named
“PARC_NUMBER,” in integer format, which contains a unique value for each parcel that can be used
to identify the associated tables of stage-volume and stage-area. The integer value must not exceed two
digits because of length restrictions for the names of ArcInfo grid files (limited to 13 characters).
Therefore, the maximum number of parcels is 99. Parcel numbers exceeding two digits may lead to the
truncation of some grid names, resulting in errors or incomplete processing. A possible workaround
when more than 99 parcels are required is to create additional polygon FeatureClasses as needed for
each group of parcels. The number of parcels must be entered into the tool_parameters.txt file (see
“Detailed Installation Instructions”). Note that parcel polygons should not overlap. Overlapping parcels
may result in misleading estimates of water or habitat parameters.

Digital Elevation Model
The Shoreline Management Tool requires a Digital Elevation Model (DEM) consisting of a raster
of land-surface elevations and, optionally, rasters of slope and aspect that cover the entire study area.
See the section “GIS_Layers Folder” in appendix A for DEM, slope, and aspect raster naming
conventions. The many DEM data sources differ with regard to their properties, which include units of
ground and elevation measurement, coordinate system, horizontal and vertical datum, spatial resolution,
spatial accuracy, and format. Of these properties, the most critical with regard to correctly and
successfully applying the Shoreline Management Tool are the units, spatial resolution, and accuracy.
The user must determine whether the DEM selected is appropriate to answer the water-resource
questions of interest to the user.
The input DEM for use with the Shoreline Management Tool must have ground units and elevation
values in meters (see “Elevations Rasters”). When selecting an appropriate DEM for use with the
Shoreline Management Tool, the user should consider the resolution and horizontal and vertical
accuracy of the DEM as well as the ratio of the area of the parcel to be investigated to the area of an
individual DEM grid cell. The resolution and accuracy determine the ability to specify the position and
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elevation of individual points on the land-surface such as the location of the shoreline at a particular
surface-water stage. The ratio of the area of the parcel to be investigated to the area of an individual
DEM grid cell determine the ability to specify the attributes of a land parcel. The values of area,
volume, and depth calculated for a parcel have smaller uncertainty associated with them for large ratios
of parcel area to DEM grid cell area because the set of errors associated with the individual estimates of
elevation for the DEM grid cells within a land parcel are assumed to be normally distributed, and the
mean error of a large set should be centered on zero. The larger the set of data (consisting of DEM grid
cells within a parcel), the greater the likelihood that the mean error is near zero. So, as the parcel size
decreases and (or) the DEM spacing increases, the uncertainty becomes greater. For example, the ratio
of a 1-acre land parcel to a 1-m DEM derived from LiDAR is 4,047 to 1 (1-acre consists of 4,047 m2 to
1 DEM point/m2). For a 1,000-acre land parcel, this ratio becomes 4,047,000 to 1, indicating a smaller
uncertainty in the estimates of area, volume, and depth. The ratio becomes 4.5 to 1 for a 1-acre parcel
and a 30-m DEM grid cell, indicating a greater uncertainty in the estimates of area, volume, and depth.
For the 34 parcels in the example study area of the lower Wood River Valley demonstrated in this
report, the mean parcel size is 1,060 acres with a minimum size of 1.6 acres, yielding ratios of parcel
area to the 1-m DEM grid cell area of about 4,300,000 to 1 and 6,500 to 1, respectively.

Elevation Rasters
The USGS National Elevation Dataset provides access to a variety of DEM data (U.S. Geological
Survey, 2012). See the section “GIS_Layers Folder” in appendix A for naming conventions. The input
DEM for use with the Shoreline Management Tool must have ground units and elevation values in
meters (all DEMs from the National Elevation Dataset are provided in meters). However, output depth
rasters created by subtracting the user-specified surface-water stage are converted to feet by the
Shoreline Management Tool (calculated as feet = meters / 0.3048). If the elevation values of the input
DEM need to be converted from units of feet to meters, the user may consider using the ArcMap >
ArcToolbox > Spatial Analyst Tools > Math > Times tool (Environmental Systems Research Institute,
Inc., 2012b) and using 0.3048 for the “constant value” (calculated as meters = feet * 0.3048). If the
ground units of the input DEM need to be converted to meters, the user may consider using the ArcMap
> ArcToolbox > Data Management Tools > Projections and Transformations > Raster > Project Raster
tool (Environmental Systems Research Institute, Inc., 2012l).
Vertical datums commonly used in the United States are the North American Vertical Datum of
1988 (NAVD88) and the National Geodetic Vertical Datum of 1929 (NGVD29) (see “Conversion
Factors and Datums”). The Shoreline Management Tool is able to use DEM data in either of these
vertical datums. Because the conversion between NAVD88 and NGVD29 varies spatially, software
such as the National Geodetic Survey VERTCON–North American Vertical Datum Conversion Utility
(National Geodetic Survey, 2012) should be used if conversion between vertical datums is desired.
To create the necessary land-surface elevation raster for each land parcel, the user may consider
first creating or acquiring a DEM that covers the entire study area and then creating individual DEM
rasters for each parcel using the ArcMap > ArcToolbox > Data Management Tools > Raster > Raster
Processing > Clip tool (Environmental Systems Research Institute, Inc., 2012c). Iteration of this tool for
different land parcel polygons may be accomplished using ArcMap ModelBuilder (Environmental
Systems Research Institute, Inc., 2012d). As an alternative a Python programming language script also
can be used to iterate the Clip tool. An example Python script is provided in the section “Python Script
to Create DEM, Slope, and Aspect Rasters, and Shoreline Polygons” (appendix D). See the section
“GIS_Layers Folder” (appendix A) for naming conventions. To obtain summary statistics on each raster
to help determine appropriate ranges of land-surface elevations for specifying surface-water stages in
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the Shoreline Management Tool then the ArcMap > ArcToolbox > Spatial Analyst Tools > Zonal >
Zonal Statistics as Table tool (Environmental Systems Research Institute, Inc., 2012e).

Slope and Aspect Rasters
The creation of slope and aspect rasters is optional. These rasters may be used as additional criteria
for specifying habitats. For best results, the DEM elevation, slope, and aspect ArcMap rasters should
use identical grid-cell size (resolution) and be aligned so that cell corners are coincident. See the section
“GIS_Layers Folder” (appendix A) for naming conventions. To obtain summary statistics on the slope
and aspect rasters to help determine appropriate ranges of slope or aspect to use for specifying habitat
criteria in the Shoreline Management Tool then the ArcMap–Zonal Statistics as Table tool may be used
(see section “Digital Elevation Model”).
The land-surface slope rasters must be represented as percent slope with values greater than or
equal to zero. The slope rasters for each parcel can be calculated first by determining the slope for the
entire DEM raster of land-surface elevation and then creating individual slope rasters for each land
parcel using either ModelBuilder or the example Python script provided in the section “Python Script to
Create DEM, Slope, and Aspect Rasters, and Shoreline Polygons” (appendix D). The ArcMap >
ArcToolbox > Spatial Analyst Tools > Surface > Slope tool will create a slope raster from the DEM
raster (Environmental Systems Research Institute, Inc., 2012f). Note that the “Output Measurement”
option should specify “PERCENT_RISE” to output the values in percent slope which is required for use
with the Shoreline Management Tool.
The land-surface aspect rasters must be represented as degrees clockwise from north, with values
greater than or equal to zero and less than or equal to 360. Negative values of aspect can be used to
represent areas that are flat (with a percent slope of 0) and, therefore, have aspect that is undefined. The
Shoreline Management Tool provides a check box allowing the user to select areas with undefined
aspect (flat areas) that are defined as negative numbers. The aspect rasters for each parcel can be
calculated by determining the aspect for the entire DEM raster of land-surface elevation and then
creating individual aspect rasters for each land parcel using ModelBuilder or the example Python script
provided in the section “Python Script to Create DEM, Slope, and Aspect Rasters, and Shoreline
Polygons” (appendix D). The ArcMap > ArcToolbox > Spatial Analyst Tools > Surface > Aspect tool
will create an aspect raster from the DEM raster (Environmental Systems Research Institute, Inc.,
2012g). Aspect is the direction of the maximum rate of change in the elevation from each cell in a raster
surface and is expressed in positive degrees from 0 to 359.9, measured clockwise from north. Cells in
the input raster, where aspect is undefined (flat areas), are assigned an aspect of -1. Note that other GIS
software may use different schemes to assign aspect values and values where aspect is undefined. The
user must ensure that the aspect raster meets the required specifications as stated in the section “Rules
for Defining Habitats.”

Inundation Layers
As an option, the user may pre-process the DEM(s) to create file geodatabase polygon FeatureClass
layers showing the shoreline of the inundated area at various increments of surface-water stage. The
FeatureClasses must be stored in FeatureDatasets within the file geodatabases organized by parcel
number. The attribute table of the inundation layers must contain a field named CF_CODE which can
be used to identify the inundation polygons. Inundation polygons must be assigned with a CF_CODE
value of 2. The ArcMap > ArcToolbox > Spatial Analyst Tools > Surface > Cut Fill tool can be used to
create a raster of the inundated areas for each increment of surface-water stage (Environmental Systems
Research Institute, Inc., 2012h). The raster of the inundated areas can be converted to polygons
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representing the shoreline using the ArcMap > ArcToolbox > Conversion Tools > Raster to Polygon
tool (Environmental Systems Research Institute, Inc., 2012i). The output polygons from the CUTFILL
operation are coded with CF_CODE = 2 for all inundated areas. The creation of the inundation rasters
and polygon FeatureClass layers can be accomplished using ArcMap ModelBuilder. As an alternative
an example Python script is provided in the section “Python Script to Create DEM, Slope, and Aspect
Rasters, and Shoreline Polygons” (appendix D). The Shoreline Management Tool is currently
programmed to use inundation layers for every tenth of a foot of surface-water stage. User-specified
surface-water stages will be rounded to the nearest 0.1 ft for selection and display of inundation layers
in the output created by the Shoreline Management Tool.

Data Tables
A single text file of the data table containing lookup tables of surface-water stage and the associated
volume and area values must be calculated for each parcel in the parcel layer and stored in a file for
each vertical datum used. The Shoreline Management Tool is currently programmed to look up values
within the data tables with increments as small as 0.01 ft of surface-water stage. Increments at greater
precision are rounded to the nearest hundredth of a foot. This is greater than the precision used for the
inundation layers (see section “Inundation Layers”). Mean depth, although not required in the data table,
can be calculated from the lookup tables as the volume divided by the area (set mean depth equal to zero
when area equals zero to avoid a divide by zero error). The user constructs data tables, consisting of
comma delimited files, for each vertical datum used, such as NAVD88 or NGVD29. An example of a
data table file for a parcel in the lower Wood River Valley is shown in figure B1. The user inserts a
header line in the first record of the file to describe the file and data fields. For the data part of the file,
subsequent records, starting with the second record, contain values of volume and area for each
increment of surface-water stage by parcel. The records for each parcel must be sorted in the order of
increasing surface-water stage. The first field of each data record must be an integer value representing
the parcel number. The second field must be a numeric value of the surface-water stage in feet for the
vertical datum represented by the file. The third field is currently unused, but if left blank should utilize
a comma delimiter. The fourth field is a numeric value of the volume in acre-feet at the specified
surface-water stage. The fifth field is currently unused, but if left blank should utilize a comma
delimiter. The sixth field is a numeric value of the inundated area in acres for the specified surfacewater stage. The remainder of the record should be blank to allow for future options. Data for
subsequent parcels should be appended below the last record for the previous parcel without repeating
the header line used in the first record of the file.
The required naming convention for the data table files are “StageLookupNAVD88.txt” or
“StageLookupNGVD29.txt”, depending on which vertical datum is being used, NAVD88 or NGVD 29,
respectively. The file(s) must be located in the Tool_Source_Files folder.
The volume and area for a given value of surface-water stage can be determined using the ArcMap
> ArcToolbox > 3D Analyst > Functional Surface > Surface Volume tool (Environmental Systems
Research Institute, Inc., 2012j). Iteration of this tool for different values of surface-water stage may be
accomplished using ArcMap ModelBuilder. As an alternative, a Python programming language script
can also be used to iterate the Surface Volume tool. An example Python script is provided in the section
“Python Script to Create Stage Lookup Data Table” in appendix D. The range of surface-water stage for
which lookup values of volume and area are available should equal or exceed the values specified in the
tool_parameters.txt file (see section “Detailed Installation Instructions”).
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Figure B1. Screen capture showing parts of a data table file for stage/volume and
stage/area lookups for Excel workbooks.
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Explanation of Input Data
The following sections contain explanations of the input data required to implement the Shoreline
Management Tool for use in the lower Wood River Valley, Oregon. The datasets for the lower Wood
River Valley, consist of the parcel layer; DEM rasters of elevation, slope, and aspect for each parcel;
stage/volume/area tables for each parcel; and inundation layers for each parcel. The datasets are
available for download at http://pubs.usgs.gov/of/2012/1247, and instructions are provided in appendix
A in the section “Download Files.” Federal Geographic Data Committee (FGDC) compliant metadata
for the geodatabase for the lower Wood River Valley example are provided in XML (Extensible
Markup Language) format and contain more detailed information on the GIS datasets (see section
“Processed_Data Folder”).

Parcel Layer for the Lower Wood River Valley
The lower Wood River Valley within the LiDAR extent was divided into 34 parcels on the basis of
land ownership and the ability of an area to be managed as an independent hydrologic unit (fig. C1).
Hydrologic independence was evaluated on the basis of the presence of dikes, roads, or other features
that could inhibit the passage of water from one parcel to an adjacent parcel at various surface-water
stages.
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Figure C1. Map showing location of example study area and outline of parcel layer for the lower Wood River
Valley, Oregon.
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Digital Elevation Model for the Lower Wood River Valley
The DEMs used for determination of the elevation, slope, and aspect of the land surface for the
implementation of the Shoreline Management Tool in the lower Wood River Valley were derived from
LiDAR surveys made of the area. LiDAR consists of raster data of latitude, longitude, and elevation
points typically collected from aircraft and having a very high resolution and accuracy. LiDAR data for
the lower Wood River Valley were collected by Watershed Sciences, Inc., on September 26–27, 2004.
The data are reported as meters of elevation referenced to the North American Vertical Datum of 1988
(NAVD88) with a horizontal output resolution (grid-cell size) of 1 m, an absolute vertical accuracy
stated to be within 13.35 cm for 95 percent of the elevation data, and a horizontal accuracy of about 55
cm (Watershed Sciences, 2005, p. 1, 9, and 11). The mean relative vertical accuracy of the LiDAR was
6.5 cm (Michael Boeder, Watershed Sciences, Inc., oral commun., 2007). A map of the values of landsurface elevation from the LiDAR data for the lower Wood River Valley is shown in figure C2.
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Figure C2. Map showing land-surface elevation from LiDAR in feet, North American Vertical Datum of 1988
(NAVD88), for the lower Wood River Valley, Oregon.
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The vertical datums commonly used by resource managers in the Klamath Basin are the North
American Vertical Datum of 1988 (NAVD88), National Geodetic Vertical Datum of 1929 (NGVD29),
and Bureau of Reclamation local vertical datum for Klamath Falls, called the Upper Klamath Lake
Vertical Datum (UKLVD) (see Conversion Factors and Datums). As part of this study, the LiDAR data
were converted from NAVD88 to NGVD29 to allow the user more options when specifying a surfacewater stage (Figure ). Because the conversion between NAVD88 and NGVD29 varies spatially, the
National Geodetic Survey’s VERTCON (North American Vertical Datum Conversion Utility) software
was used for the conversion (National Geodetic Survey, 2012). The conversions from the national
vertical datums NAVD88 and NGVD29 to UKLVD vary spatially and are presently not well defined for
much of the lower Wood River Valley. For the purpose of this study, the conversion from NGVD29 to
UKLVD used a constant value across the study area and is represented by the following equation:
UKLVD = NGVD29 + 1.78 (values are in feet) (William Wood, Bureau of Reclamation, written
commun., 2007).
Surface-water stage elevations entered by the user using the UKLVD are converted by the
Shoreline Management Tool internally to an equivalent elevation in NGVD29, which is used for
processing and calculations. Maps of the values of land-surface elevation from the LiDAR data for the
lower Wood River Valley in the NAVD88, NGVD29, and UKLVD vertical datums converted to feet
are shown in figures C2, C3, and C4, respectively, for comparison. Summary statistics of the landsurface elevations for each of the parcels delineated for the lower Wood River Valley for each vertical
datum are presented in table C1. The elevation estimates in the data tables are limited to the accuracy of
the LiDAR data and the accuracy of the National Geodetic Survey VERTCON software (±2 cm), which
was used for elevation conversion to NGVD29 and, subsequently, for UKLVD.
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Figure C3. Map showing land-surface elevation from LiDAR in feet, National Geodetic Vertical Datum of 1929
(NGVD29), for the lower Wood River Valley, Oregon.
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Figure C4. Map showing land-surface elevation from LiDAR in feet, Upper Klamath Lake Vertical Datum (UKLVD),
for the lower Wood River Valley, Oregon.
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Table C1. Summary statistics of land-surface elevations from LiDAR for land parcels delineated for the lower Wood River Valley, Oregon, for three
vertical datums: North American Vertical Datum of 1988 (NAVD88), National Geodetic Vertical Datum of 1929 (NGVD29), and Upper Klamath Lake
Vertical Datum (UKLVD).
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Inundation Layers for the Lower Wood River Valley
Inundation layers for each land parcel in the lower Wood River Valley in the form of file
geodatabase polygon FeatureClasses were developed using the ArcMap CUTFILL command using the
1-m resolution LiDAR data to show the area of land that is inundated by water with a change in surfacewater stage for every tenth of a foot. A map depicting an example of these inundation layers for parcels
9, 10, 16, and 33 at a surface-water stage of 4,138.80 ft NAVD88 is presented in fig. C5. In this
example, all but east-west linear traces of dikes are inundated in parcels 9, 10, and 33. Because parcel
16 is at a higher elevation, only a part of that area is inundated.
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Figure C5. Map showing the water inundation for parcels 9, 10, 16, and 33 at surface-water stage 4,138.80 feet
North American Vertical Datum of 1988 (NAVD88), lower Wood River Valley, Oregon.
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Data Tables for the Lower Wood River Valley
For the lower Wood River Valley, each of the 34 parcels has associated tables containing volume
and area values computed for surface-water stages in increments of 0.01 ft. The stage–area–volume
relationship analysis was conducted for both NAVD88 and NGVD29 vertical datums created using a 1m resolution DEM. The NGVD29 tables contain a field named “STAGE_BR” that has the Bureau of
Reclamation equivalent surface-water stage using UKLVD for the NGVD29 stage value in the field
named “STAGE_FT.” These tables contain the surface-water stage, volume of storage, and area of
inundation. The surface-water stage is in feet, volume of storage is in cubic meters and acre-feet, and
area of inundation is in square meters and acres. Examples of the naming convention for the tables are
listed below for parcel number 33. Note that parcel numbers do not include any leading zeros. The
suffixes of 88 and 29 indicate the vertical datum (NAVD88 and NGVD29) used for the surface-water
stage.
PARC_33_88 vertical datum of NAVD88
PARC_33_29 vertical datum of NGVD29
The stage/volume/area tables have the following fields:
STAGE_FT – surface-water stage, in feet
VOLMTR3 – volume of storage, in cubic-meters
AREAMTR2 – area of inundation, in square-meters
VOLACRFT – volume of storage, in acre-feet [calculated as VOLMTR3 * 0.0008107]
AREAACRE – area of inundation, in acres [calculated as AREAMTR2 * 0.0002471]
In the NGVD29 tables, an additional field is provided that stores the UKLVD stage equivalent:
STAGE_BR – surface-water stage, in UKLVD feet
An example of a data table for parcel 33 is presented in table C2 and shown graphically in figure
C6. As might be expected, the volume and inundated area increase with increasing surface-water stage.
The volume and inundated area increase gradually with increases of stage except, however, between
4,138.81 and 4,138.82 ft, where the inundated area increases significantly because much more of the
area is at elevation 4,138.82 ft than the elevation just above or below 4,138.82 ft. Water managers can
use data tables such as table C2 to estimate the storage gained and water available for release for a given
surface-water stage.
Table C2. Example of data table for surface-water stages 4,138.80–4,138.84 feet NAVD88 in
parcel 33, lower Wood River Valley, Oregon.
STAGE_FT
Surface-water
elevation, in feet
NAVD88
4,138.80
4,138.81
4,138.82
4,138.83
4,138.84

VOLMTR3
Storage volume,
in cubic meters

AREAMTR2
Inundated area, in
square meters

VOLACRFT
Storage volume,
in acre-feet

AREAACRE
Inundated area, in
acres

1,405,660
1,429,880
1,454,610
1,479,510
1,504,400

7,937,410
7,937,510
8,156,920
8,156,980
8,157,060

1,139.57
1,159.20
1,179.25
1,199.44
1,219.62

1,961.33
1,961.36
2,015.57
2,015.59
2,015.61
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Figure C6. Graph showing examples of the stage/area, stage/volume, and stage/mean depth relationships for the
NAVD88 vertical datum for parcel 33, lower Wood River Valley, Oregon.
A comparison of the stage/volume/area data tables for NAVD88 and NGVD29 vertical datums for
individual land parcels for equivalent values of stage shows very small differences. These differences
are a result of the tables being calculated independently for each vertical datum. However, the land
surface represented by NAVD88 and NGVD29 are not exactly the same and varies spatially by a small
amount over each land parcel. These differences also may affect the depth, slope, and aspect of each
land parcel and may be reflected as differences in the results of the habitat areas that match the criteria
for factors when compared between vertical datums. Values of volume and area for stages using the
UKLVD are obtained directly from NGVD29 data tables for equivalent stages and have exactly the
same values of area and volume for each value of equivalent stage.
An Excel workbook containing the stage/volume, stage/area, and stage/mean depth lookup tables
and graphs for individual parcels within the lower Wood River Valley is provided in the file
lower_Wood_River_Valley_Stage_Vol_Area_Lookups.xlsx in the Tool_Source_Files folder (see
section “Tool_Source_Files Folder”). Note that this file is not needed to run the Shoreline Management
Tool and is provided as a convenience to the user.
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Appendix D. Example Python Programming Language Scripts to Automate Data
Preparation for the Shoreline Management Tool
This appendix provides two example Python programming language scripts (Environmental
Systems Research Institute, Inc., 2012k) for automating the preparation of the input data for use with the
Shoreline Management Tool. The script Create_DEM_Slope_Aspect_Rasters_and_Shoreline_v2.py can
be used to create individual DEM, slope, and aspect rasters for each land parcel. In addition, the script
can be used to create file geodatabase polygon FeatureClass layers showing the shoreline of the
inundated area for each parcel at user-specified increments of surface-water stage (see section
“Inundation Layers” in appendix B). The results from the script
Create_DEM_Slope_Aspect_Rasters_and_Shoreline_v2.py can then be used as input for the script
Create_Stagelookup_Data_Table_v2.py that is used to develop a text file of stage–volume–area lookup
values (see section “Data Tables” in appendix B). The scripts are configured to develop the input data
for the example implementation for the lower Wood River Valley in southern Oregon (appendix C).
However, the scripts are designed to be easily modified for use in other areas. The scripts have only
been minimally test and are provided “as is.” Corrections or suggestion are welcome and should be sent
to Dan Snyder dtsnyder@usgs.gov. NOTE: Because this PDF file incorporates page numbers and
does not retain spaces necessary for the correct indentation of certain Python functions, users are
advised to download the Python scripts directly from http://pubs.usgs.gov/of/2012/1247, where
updates may also be available.
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Python Script to Create DEM, Slope, and Aspect Rasters, and Shoreline Polygons
The following script, Create_DEM_Slope_Aspect_Rasters_and_Shoreline_v2.py, can be used to clip a DEM raster to each
polygon of a parcel layer creating one DEM raster per parcel (see section “Elevation Rasters” in appendix B) as required for the
Shoreline Management Tool. The script is also capable of creating slope and aspect rasters and clipping these to each polygon of a
parcel layer creating one slope and/or aspect raster per parcel (see section “Slope and Aspect Rasters” in appendix B) as an option for
use with the Shoreline Management Tool. Finally, the script can be used to create file geodatabase polygon FeatureClass layers
showing the shoreline of the inundated area for each parcel at user-specified increments of surface-water stage (see section
“Inundation Layers” in appendix B). Instructions on use of the script are included in the comments within the programming code.
User-specified parameters are contained within a single section of the program titled “USER-DEFINED VARIABLES” and which is
highlighted in yellow text. For most applications, the remainder of the program code should not need to be modified.
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######################################################################################################################################
# $Id: Create_DEM_Slope_Aspect_Rasters_and_Shoreline_v2.py
#
# Project: Create_DEM_Slope_Aspect_Rasters_and_Shoreline (version 2)
# Purpose: This script can be used to:
#
Create a Slope raster for the entire study area using the DEM for the study area.
#
Create an Aspect raster for the entire study area using the DEM for the study area.
#
Clip the study area DEM
raster using the land parcel layer to create individual DEM
rasters for each parcel.
#
Clip the study area Slope raster using the land parcel layer to create individual Slope rasters for each parcel.
#
Clip the study area Aspect raster using the land parcel layer to create individual Aspect rasters for each parcel.
#
Create individual rasters
of the shoreline for each parcel at each increment of stage.
#
Create individual file geodatabase polygon featureclass of the shoreline for each parcel at each increment of stage.
#
(Increments and min and max elevation values of surface-water stage are user specified.)
#
#
This script is intended for use in data preparation for the Shoreline Management Tool
#
Snyder, D.T., Haluska, T.L., and Respini-Irwin, D., 2012,
#
The Shoreline Management Tool#
An ArcMap tool for analyzing water depth,
#
inundated area, volume, and selected habitats,
#
with an example for the lower Wood River Valley, Oregon:
#
U.S. Geological Survey Open-File Report 2012-1247,
#
available at http://pubs.usgs.gov/of/2012/1247.
#
#
Important Notice: This script has only been minimally tested, is provided "as is," and must be modified for use.
#
Corrections or suggestion are welcome and should be sent to Dan Snyder dtsnyder@usgs.gov
#
Check for updates at: http://pubs.usgs.gov/of/2012/1247.
#
#
Rasters of Elevation, Slope, and Aspect
#
The Shoreline Management Tool requires Digital Elevation Models (DEMs) consisting of rasters of land-surface
#
elevations for each individual land parcel (land area) with the parcel layer. The DEMs are used to create rasters
#
of water depth by subtracting the land-surface DEM from a user-specified water elevation (stage).
Values in the
#
depth rasters are used to determine whether areas will be inundated in a particular scenario and the resulting
#
water depths. The Shoreline Management Tool requires the input DEM to have ground units and elevation values in
#
meters. The DEM may be optionally processed to develop individual rasters of slope and aspect of the land-surface
#
for comparison with the user-specified habitat definitions if these criteria are desired.
#
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#
Inundation Layers
#
As an option, the user may create rasters showing the shoreline of the inundated area for individual parcels at each
#
increment of surface-water stage. The rasters are then used to create file geodatabase polygon FeatureClasses than
#
can be used to show the extent of inundated areas.
#
#
For the creation of individual DEM, Slope, or Aspect rasters for individual parcels, run time depends on
#
DEM resolution, parcel area, number of parcels, CPU, and software.
#
The following run times were obtained using the 56.4 sq. mile (146 sq. km) Lower Wood River Valley, Oregon example
#
having 34 parcels with a 1-m DEM using
#
ArcMap 10.0 SP 5 on a Windows 7 64-bit, processor - Intel Xeon CPU X5570 @ 2.93 GHz, RAM = 3 GB:
#
Settings (run times are for each option indicated):
#
doDEM
= "YES"
1.2 hrs (includes creation of individual DEM rasters for each parcel)
#
doSlope
= "YES"
0.6 hrs (includes creation of overall slope raster and individual rasters for each parcel)
#
doAspect
= "YES"
0.6 hrs (includes creation of overall slope raster and individual rasters for each parcel)
#
#
For the creation of individual file geodatabase featureclass polygons representing the shoreline for each parcel at
#
each increment of stage (elevation), run time depends on the factors listed above as well as the stage range,
#
and increment level. Using the example cited above, stage elevations ranging from 4135.30 - 4176.30 feet and
#
an increment level of 0.1 feet the following run time was estimated as:
#
doShoreline = "YES" 173.9 hrs (includes creation of individual shoreline rasters and file geodatabase
#
featureclass polygons for each parcel at each 0.1 ft increment of stage
#
also includes time for doDEM="YES" which is a requirement)
#
The run times can be quite long for large stage ranges with small increments levels. It may be more manageable
#
for some users to break the large stage ranges into several runs consisting of smaller stage ranges to achieve
#
shorter run times, though the overall time to obtain the full set of increments over the entire stage range
#
would remain about the same. Using the Lower Wood River Valley as an example and using incElev_feet = 0.1 :
#
Run 1 startElev_feet = 4135.30 endElev_feet = 4140.30
#
Run 2 startElev_feet = 4140.40 endElev_feet = 4145.30
#
Run 3 startElev_feet = 4145.40 endElev_feet = 4150.30
#
Run 4 startElev_feet = 4150.40 endElev_feet = 4155.30
#
Run 5 startElev_feet = 4155.40 endElev_feet = 4160.30
#
Run 6 startElev_feet = 4160.40 endElev_feet = 4165.30
#
Run 7 startElev_feet = 4165.40 endElev_feet = 4170.30
#
Run 8 startElev_feet = 4170.40 endElev_feet = 4175.30
#
Run 9 startElev_feet = 4175.40 endElev_feet = 4176.30
#
Will produce the same output in runs of about 20 hours each.
#
#
Note that it did not appear to take longer if messages were output to the screen for each iteration.
#
######################################################################################################################################
#
# Version
= 2.0
# Version Date = January 23, 2013
# Original Author: Joel E. Robinson jrobins@usgs.gov
April 13, 2012
# Modified by:
Curtis V. Price
cprice@usgs.gov
April 13, 2012
# Modified by:
Leonard L. Orzol llorzol@usgs.gov
January 23, 2013
# Modified by:
Daniel T. Snyder dtsnyder@usgs.gov January 23, 2013
# Contact:
Daniel T. Snyder dtsnyder@usgs.gov
#
U.S. Geological Survey (USGS) Oregon Water Science Center
#
http://or.water.usgs.gov
#
######################################################################################################################################
# THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESSED

# OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
# FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL
# THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
# LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
# FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
# DEALINGS IN THE SOFTWARE.
######################################################################################################################################
#
# Assumption: The DEM is in elevation units of meters and ground units of meters.
#
Use of a DEM in units other than meters will require modification of the script.
#
# Warning 1: If the name used for the output polygon featureclass "parcel_poly_name" exists anywhere in the file geodatabase, then
#
the script will fail with the following message "ERROR 0000582: Error occurred during execution"
#
It may be possible to successfully overwrite an existing featureclass if it is in the exact same location within the
#
file geodatabase.
#
# Warning 2: Error messages while running the script might result from previously existing files or directories (though in some
#
instances previously existing directories are required. To avoid some of these errors this script is designed to
#
delete or overwrite some existing files.
#
# Suggestion: To save a text file of the screen output while running this script use the following command:
#
Create_DEM_Slope_Aspect_Rasters_and_Shoreline_v2.py | tee Create_DEM_Slope_Aspect_Rasters_and_Shoreline_v2_output.txt
#
Note that the "|" is the redirect symbol and "tee" will send output to both the screen and the text file.
#
######################################################################################################################################
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# Import system modules.
import sys
import os
import time
import arcinfo
import arcpy
from arcpy import env as ENV
# Set up Spatial Analyst.
arcpy.CheckOutExtension("Spatial")
from arcpy.sa import *

# map algebra syntax for SA tools

starttime = time.clock()
arcpy.AddMessage("%s" % ("")) #space
arcpy.AddMessage("%s" % ("")) #space
arcpy.AddMessage("%s" % ("")) #space
arcpy.AddMessage("%s %s" % ("Starting
arcpy.AddMessage("%s" % ("")) #space

out
out
out
",
out

screen messages
screen messages = time.clock()
screen messages
time.strftime("%I:%M:%S", time.localtime())))
screen messages

arcpy.AddMessage("%s" % ("Setting Workspace and settings"))

### *************************************************** USER-DEFINED VARIABLES *******************************************************
### **********************************************************************************************************************************
### **********************************************************************************************************************************
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### Begin Setting Variables (***!!!these need to be set by user!!!***)
### This is the only place that generally would need to be modified by the user for their project.
###
###
inDEMpath
= r"F:\ShorelineDirectory\GIS_Layers" + os.sep # String: Path to input DEM of entire area of land parcels.
###
#
Do not include a trailing "\" at end.
inDEMname
= "bare_patch29"
# String: Name of input DEM of entire area of land parcels.
inDEMdatum = "NGVD29"
# String: Vertical datum of input DEM: "NAVD88" or "NGVD29".
inDEMres
= 1
# Integer: Lateral resolution of DEM in meters
###
#
(rounded to integer) typically 1, 5, 10, or 30.
###
inGDBpath
= r"F:\ShorelineDirectory\Processed_Data" + os.sep # String: Path to input geodatabase containing parcel FeatureClass.
#
#
REQUIREMENT: must be located within ShorelineDirectory\Processed_Data\.
###
#
Do not include a trailing "\" at end.
inGDBname
= "ShorelineManagementTool_NGVD29.gdb"
# String: Name of input geodatabase containing parcel FeatureClass.
#
#
REQUIREMENT: acceptable names must be consistent with value of inDEMdatum:
#
#
ShorelineManagementTool_NGVD29.gdb or ShorelineManagementTool_NGVD29.gdb
inFCname
= "Parcels"
# String: Name of input FeatureClass with parcel polygons.
#
#
REQUIREMENT: inFCname = "Parcels".
###
doDEM
= "YES"
# String: Create individual DEM
rasters for each parcel. "YES" or "NO".
doSlope
= "YES"
# String: Create individual Slope rasters for each parcel. "YES" or "NO".
doAspect
= "YES"
# String: Create individual Aspect rasters for each parcel. "YES" or "NO".
doShoreline = "YES"
# String: Create individual rasters and file geodatabase polygon.
###
#
FeatureClass of the shoreline for each increment of stage
###
#
between the starting and ending elevations.
###
#
Repeat for each parcel. "YES" or "NO".
###
#
(CO-REQUIREMENT: doDEM = "YES").
###
out_DEM_folder_path = r"F:\ShorelineDirectory\GIS_Layers" # String: Path to output folder that will contain output rasters of
###
#
DEMs, SLOPE, & ASPECT created from full DEM for each parcel.
###
#
Do not include a trailing "\" at end.
out_folder_path
= r"F:\ShorelineDirectory\GIS_Layers" + os.sep # String: Path to output folder that will contain
###
#
output workspace with shoreline rasters.
###
#
Do not include a trailing "\" at end.
out_workspace_name = "shoreline_rasters_NGVD29"
# String: Name of output workspace for shoreline rasters.
###
outGDBpath = r"F:\ShorelineDirectory\Processed_Data" + os.sep # String: Path to output file geodatabase containing rasters and
#
#
FeatureClass polygons representing the shoreline for
#
#
parcel at every increment of stage.
#
#
REQUIREMENT: must be located within ShorelineDirectory\Processed_Data\.
###
#
Do not include a trailing "\" at end.
outGDBname = "ShorelineManagementTool_NGVD29.gdb"
# String: Name of output file geodatabase
#
#
REQUIREMENT: acceptable names must be consistent with value of inDEMdatum:
#
#
ShorelineManagementTool_NGVD29.gdb or ShorelineManagementTool_NGVD29.gdb
###
startElev_feet = 4135.30
# Float:
Start elev level (in feet) NOTE: must be the LOWER elev value.
#
#
Note: elevation datum is value of inDEMdatum.
endElev_feet
= 4176.30
# Float:
End
elev level (in feet) NOTE: must be the UPPER elev value.
#
#
Note: elevation datum is value of inDEMdatum.
incElev_feet
=
0.10
# Float:
Elevation increment to use for iteration (units in feet).
#
#
Value will be rounded to "numDecimals" set below.
numDecimals
= 1
# Integer: Number of decimals to round feet elevation values.

#
#
###
###
###
###
###
###

#
#

Warning: values > 2 may result in duplicate rasters names
due to truncation from raster name length limitations.

End Setting Variables (user should not normally need to modify script below this point).
**********************************************************************************************************************************
**********************************************************************************************************************************
**********************************************************************************************************************************
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# Write to screen the parameters specified for the run.
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s" % ("USER-SPECIFIED INPUT PARAMETERS:"))
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s %s" % ("
Path to input DEM that includes entire area of land parcel coverage (inDEMpath) =", inDEMpath))
arcpy.AddMessage("%s %s" % ("
Name of input DEM that includes entire area of land parcel coverage (inDEMname) =", inDEMname))
arcpy.AddMessage("%s %s" % ("
Vertical datum of input DEM: either NAVD88 or NGVD29
(inDEMdatum) =", inDEMdatum))
arcpy.AddMessage("%s %i" % ("
Lateral resolution of DEM in meters rounded to nearest integer
(inDEMres)
=", inDEMres))
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s %s" % ("
Path to input file geodatabase containing parcels FeatureClass (inGDBpath) =", inGDBpath))
arcpy.AddMessage("%s %s" % ("
Name of input file geodatabase containing parcels FeatureClass (inGDBname) =", inGDBname))
arcpy.AddMessage("%s %s" % ("
Name of input FeatureClass with parcel polygons
(inFCname) =", inFCname))
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s %s" % ("
Create individual DEM
rasters for each parcel YES/NO (doDEM)
=", doDEM))
arcpy.AddMessage("%s %s" % ("
Create individual Slope rasters for each parcel YES/NO (doSlope) =", doSlope))
arcpy.AddMessage("%s %s" % ("
Create individual Aspect rasters for each parcel YES/NO (doAspect) =", doAspect))
arcpy.AddMessage("%s %s" % ("
Create shoreline rasters & polys by parcel & stage increment YES/NO (doShoreline) =", doShoreline))
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s %s" % ("
Path to output folder that will contain output DEMs (out_DEM_folder_path) =", out_DEM_folder_path))
arcpy.AddMessage("%s %s" % ("
Path to output folder of workspace of shoreline rasters (out_folder_path)
=", out_folder_path))
arcpy.AddMessage("%s %s" % ("
Name of output workspace for shoreline rasters
(out_workspace_name) =", out_workspace_name))
arcpy.AddMessage("%s %s" % ("
Path to output file geodatabase for shoreline polygons (outGDBpath)
=", outGDBpath))
arcpy.AddMessage("%s %s" % ("
Name of output file geodatabase for shoreline polygons (outGDBname)
=", outGDBname))
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s %f %s" % ("
Starting Elevation, in ft
(startElev_feet) =", startElev_feet, inDEMdatum))
arcpy.AddMessage("%s %f %s" % ("
Ending
Elevation, in ft
(endElev_feet)
=", endElev_feet,
inDEMdatum))
arcpy.AddMessage("%s %f" %
("
Increment, in ft
(incElev_feet)
=", incElev_feet))
arcpy.AddMessage("%s %i" %
("
Num. decimals to round elev, in ft (numDecimals)
=", numDecimals))
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s" % ("BEGIN:"))
arcpy.AddMessage("%s" % ("")) #space out screen messages

# Create full pathnames.
inDEM
= os.path.join(inDEMpath, inDEMname)
inFC_clipFeat = os.path.join(inGDBpath, inGDBname, inFCname)
outGDB
= os.path.join(outGDBpath, outGDBname)
outWrkspace
= os.path.join(out_folder_path, out_workspace_name)

#
#
#
#

Full
Full
Full
Full

path
path
path
path

and
and
and
and

name
name
name
name

for
for
for
for

input DEM.
input FeatureClass - parcel polygons.
output file geodatabase - shoreline.
output workspace of shoreline rasters.

# Check to see if output workspace for the shoreline rasters exists or must be created.
if arcpy.Exists(outWrkspace):
arcpy.AddMessage("%s %s" % ("
Using existing workspace for shoreline rasters: ", outWrkspace))
else:
arcpy.CreateArcInfoWorkspace_management(out_folder_path, out_workspace_name)
# Execute CreateArcInfoWorkspace.
arcpy.AddMessage("%s %s" % ("
Creating workspace for shoreline rasters: ", outWrkspace))
# Write to screen the output locations.
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s %s" % ("
Input DEM
(inDEM)
arcpy.AddMessage("%s %s" % ("
Input parcels for clipping
(inFC_clipFeat)
arcpy.AddMessage("%s %s" % ("
Output file geodatabase for rasters and polygons (outGDB)
arcpy.AddMessage("%s %s" % ("
Output workspace for shoreline rasters
(outWrkspace)
arcpy.AddMessage("%s" % ("")) #space out screen messages

=",
=",
=",
=",

inDEM))
inFC_clipFeat))
outGDB))
outWrkspace))

# Basic settings.
#
ENV.overwriteOutput = 1
ENV.snapRaster
= inDEM
ENV.cellSize
= inDEM
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if inDEMdatum == "NAVD88":
inDEMdatumYR = "88"
elif inDEMdatum == "NGVD29":
inDEMdatumYR = "29"
else:
inDEMdatumYR = "XX"

# Round increment to user-specified number of decimals to prevent deviations due to floating point values.
incElev_feet = round(incElev_feet,numDecimals)
if doSlope.upper() == 'YES':
# Create slope raster from full DEM to later be cut into individual parcel-sized slope rasters.
# Note: Assumes that ground units and elevation units of DEM are in meters.
#
Otherwise the "z_factor" will need to be changed.
z_factor
= 1.0
outSLPname = "SLP_" + str(inDEMres) + "m" + inDEMdatumYR + ".img"
outSLP
= os.path.join(out_DEM_folder_path,outSLPname)
# Check to see if outSLP slope raster exists, if so, delete.
if arcpy.Exists(outSLP):
arcpy.AddMessage("%s %s" % ("Deleting previous version of Slope raster (outSLP): ", outSLP))
arcpy.Delete_management(outSLP)
arcpy.AddMessage("%s %s" % ("Input DEM raster for creation of Slope raster = ",inDEM))
outSlope
= Slope(inDEM, "PERCENT_RISE", z_factor)
outSlope.save(outSLP)
arcpy.AddMessage("%s %s" % ("Slope raster of entire DEM stored as = ", outSLP))
arcpy.AddMessage("%s" % ("")) #space out screen messages
if doAspect.upper() == 'YES':
# Create aspect raster from full DEM to later be cut into individual parcel-sized aspect rasters.
outASPname = "ASP_" + str(inDEMres) + "m" + inDEMdatumYR + ".img"

outASP
= os.path.join(out_DEM_folder_path,outASPname)
# Check to see if outSLP slope raster exists, if so, delete.
if arcpy.Exists(outASP):
arcpy.AddMessage("%s %s" % ("Deleting previous version of Aspect raster (outASP): ", outASP))
arcpy.Delete_management(outASP)
arcpy.AddMessage("%s %s" % ("Input DEM raster for creation of Aspect raster = ",inDEM))
outAspect = Aspect(inDEM)
outAspect.save(outASP)
arcpy.AddMessage("%s %s" % ("Aspect raster of entire DEM stored as = ", outASP))
arcpy.AddMessage("%s" % ("")) #space out screen messages
# Name of OID field.
fieldName = "PARC_NUMBER"
cursor = arcpy.SearchCursor(inFC_clipFeat)
for poly in cursor:
mask = poly.PARC_NUMBER
# Create feature layer of current mask polygon.
whereClause = fieldName + " = " + str(mask)
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s %s" % ("Currently processing Parcel: ", whereClause))
arcpy.MakeFeatureLayer_management(inFC_clipFeat, 'currentMask', whereClause)
currentMask_value = 'currentMask'
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if doDEM.upper() == 'YES' or doShoreline.upper() == 'YES':
# Create and save the clipped DEM raster.
outDEMraster = arcpy.sa.ExtractByMask(inDEM, 'currentMask')
outDEMname = "p" + str(mask) + "_" + str(inDEMres) + "mdem" + inDEMdatumYR
arcpy.AddMessage("%s %s" % ("Output path and name for Parcel DEM
raster = ", outWrkspace + os.sep + outDEMname))
outDEMraster.save(outWrkspace + os.sep + outDEMname)
if doSlope.upper() == 'YES':
# Create and save the clipped SLOPE raster (do only once for each entire parcel without regard for stage).
outSLPraster = arcpy.sa.ExtractByMask(outSLP, 'currentMask')
outSLPname = "p" + str(mask) + "_" + str(inDEMres) + "mslp"
arcpy.AddMessage("%s %s" % ("Output path and name for Parcel Slope raster = ", outWrkspace + os.sep + outSLPname))
outSLPraster.save(outWrkspace + os.sep + outSLPname)
if doAspect.upper() == 'YES':
# Create and save the clipped SLOPE raster (do only once for each entire parcel without regard for stage).
outASPraster = arcpy.sa.ExtractByMask(outASP, 'currentMask')
outASPname = "p" + str(mask) + "_" + str(inDEMres) + "masp"
arcpy.AddMessage("%s %s" % ("Output path and name for Parcel Aspect raster = ", outWrkspace + os.sep + outASPname))
outASPraster.save(outWrkspace + os.sep + outASPname)

# Initialize reference plane elevation (in feet) and round to user-specified number of decimals.
refElev_feet = round(startElev_feet,numDecimals)
# Round prevents deviations due to floating point values.

if doShoreline.upper() == 'YES':
# For each parcel, loop through reference plane elevations incrementally to create rasters associated with each elevation.
#

# Create a new Feature Dataset to hold the results.
featureDataset = "InundationAreasParcel_" + str(mask)
arcpy.AddMessage("%s %s" % ("outGDB
= ", outGDB))
arcpy.AddMessage("%s %s" % ("featureDataset = ", featureDataset))
arcpy.AddMessage("%s %s" % ("inFC_clipFeat = ", inFC_clipFeat))
# Check to see if output featureDataset for shoreline polygon exists within file geodatabase or must be created.
if arcpy.Exists(outGDB + os.sep + featureDataset):
arcpy.AddMessage("%s %s" % ("
Using existing output featureDataset for shoreline polygons: ", outGDB + os.sep +
featureDataset))
else:
arcpy.AddMessage("%s %s" % ("
Creating output featureDataset for shoreline polygons: ", outGDB + os.sep + featureDataset))
arcpy.CreateFeatureDataset_management(outGDB, featureDataset, inFC_clipFeat)
try:
# Return a new output for every change of incElev elevation unit.
# SurfaceVolume appends data if the file exists already, though we won't be using this output.
#
arcpy.AddMessage("%s %f" % ("Reference Elevation, in_feet = ", refElev_feet))
while refElev_feet <= endElev_feet:
arcpy.AddMessage("%s %f" % ("refElev_feet = ", refElev_feet))
refElev_feetx100 = round(refElev_feet * 100,0)
# Round to prevent deviations due to floating point values.
arcpy.AddMessage("%s %f" % ("refElev_feetx100 = ", refElev_feetx100))
refElev_feetx100_str = str( "%06d" % refElev_feetx100)
arcpy.AddMessage("%s %s" % ("refElev_feetx100_str = ", refElev_feetx100_str))
arcpy.AddMessage("%s %f" % ("incElev_feet = ", incElev_feet))
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refElev_meters
= refElev_feet/3.280833
# Reference plane elevation converted to meters.
# Select only for those cells that are less than or equal to Reference Elevation.
whereClause2 = "VALUE <= " + str(refElev_meters)
arcpy.AddMessage("%s %s" % ("whereclause2 = ", whereClause2))
# Set raster value to "2" for polygons representing inundated areas (needed later for "CF_CODE").
parcel_raster = Con(outDEMraster, 2, 0, whereClause2)
# Save the grids permanently (note the use of short names, as 13 is the maximum grid name length).
# Create output raster name.
parcel_raster_name = "p" + str(mask) + refElev_feetx100_str
parcel_raster_output = outWrkspace + os.sep + parcel_raster_name
arcpy.AddMessage("%s %s" % ("parcel_raster_output = ", parcel_raster_output))
parcel_raster.save(parcel_raster_output)
# Convert the rasters to polygon using ArcMap > ArcToolbox > Conversion Tools > Raster to Polygon tool.
# Output polygons for inundated areas have CF_CODE = 2 which is required for Shoreline Management Tool.
# Create polygon name using parcel number and reference elevation.
parcel_poly_name = "p" + str(mask) + refElev_feetx100_str + "_polygon"
parcel_poly_output = outGDB + os.sep + featureDataset + os.sep + parcel_poly_name
arcpy.AddMessage("%s %s" % ("parcel_poly_name
= ", parcel_poly_name))
arcpy.AddMessage("%s %s" % ("parcel_poly_output = ", parcel_poly_output))
# Check to see if parcel_poly_output shoreline polygon exists, if so, delete.
if arcpy.Exists(outGDB + os.sep + parcel_poly_name):
arcpy.AddMessage("%s %s" % ("Deleting all previous versions of shoreline polygon (parcel_poly_name): ",
parcel_poly_name))
arcpy.AddMessage("%s %s" % ("
that occur anywhere within the file geodatabase (outGDB): ", outGDB))
arcpy.Delete_management(outGDB + os.sep + parcel_poly_name)

arcpy.RasterToPolygon_conversion(parcel_raster_output, parcel_poly_output, "NO_SIMPLIFY", "VALUE")
# Add field called CF_CODE and set equal to "VALUE" (GRIDCODE).
# Output polygons for inundated areas have CF_CODE = 2 which is required for Shoreline Management Tool.
arcpy.AddField_management(parcel_poly_output, "CF_CODE", "DOUBLE", 10, "0", "", "CF_CODE", "NULLABLE", "REQUIRED")
arcpy.CalculateField_management(parcel_poly_output, "CF_CODE", "!grid_code!", "PYTHON")
# Increment the refPlane elevation and loop and round to user-specified number of decimals.
refElev_feet = round(refElev_feet + incElev_feet,numDecimals) # Round prevents deviations due to floating point values.
except Exception, msg:
arcpy.AddMessage(str(msg))
arcpy.Delete_management('currentMask')
if arcpy.Exists('currentMask'):
arcpy.Delete_management('currentMask')
del cursor, poly
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s" % ("")) #space out screen messages
stoptime = time.clock()
arcpy.AddMessage("%s %s" % ("DONE: ", time.strftime("%I:%M:%S", time.localtime())))
arcpy.AddMessage("%s %.1f" % ("Elapsed time in minutes: ", ((stoptime-starttime)/60)))
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Python Script to Create Stage Lookup Data Table
The following script, Create_Stagelookup_Data_Table_v2.py, can be used to iterate the ArcMap Surface Volume tool
(Environmental Systems Research Institute, Inc., 2012j) to create a text file of stage–volume–area lookup values (see section “Data
Tables” in appendix B) that is required for use of the Shoreline Management Tool. Instructions on use of the script are included in the
comments within the programming code. User-specified parameters are contained within a single section of the program titled
“USER-DEFINED VARIABLES” and which is highlighted in yellow text. For most applications, the remainder of the program code
should not need to be modified. Note that this script should typically be run after running the
Create_DEM_Slope_Aspect_Rasters_and_Shoreline_v2.py script the results of which are used as input for the current script.
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######################################################################################################################################
# $Id: Create_Stagelookup_Data_Table_v2.py
#
# Project: Create_Stagelookup_Data_Table (version 2)
# Purpose: This script can be used to iterate the ESRI ArcMap 3D Analyst Surface Volume tool to
#
create a comma delimited text file listing the outputs of the Surface Volume function
#
for a Tin or DEM using user-specified increments of surface-water stage (elevation) between
#
minimum and maximum values of stage as specified by the user. It will perform the iteration
#
through the range of stage values for each land parcel DEM listed in an input text file.
#
#
This script is intended for use in data preparation for the Shoreline Management Tool
#
Snyder, D.T., Haluska, T.L., and Respini-Irwin, D., 2012,
#
The Shoreline Management Tool#
An ArcMap tool for analyzing water depth,
#
inundated area, volume, and selected habitats,
#
with an example for the lower Wood River Valley, Oregon:
#
U.S. Geological Survey Open-File Report 2012-1247,
#
available at http://pubs.usgs.gov/of/2012/1247.
#
#
Important Notice: This script has only been minimally tested, is provided "as is," and must be modified for use.
#
Corrections or suggestion are welcome and should be sent to Dan Snyder dtsnyder@usgs.gov
#
Check for updates at http://pubs.usgs.gov/of/2012/1247.
#
#
Data tables containing lookup tables of surface-water stage and the associated volume and area values
#
must be calculated for each parcel polygon in the land parcel layer. The data tables consist of
#
comma-delimited files that should be constructed for each vertical datum required by the user,
#
such as NAVD88 or NGVD29. The data tables must have values of surface-water stage in feet,
#
volume of storage in acre-feet, and area of inundation in acres.
#
The Shoreline Management Tool is currently programmed to look up values within the data tables
#
with stage increments of 0.01 ft.
#
#
The header line in the first record of the file is used to describe the file and data fields.
#
For the data part of the file, subsequent records, starting with the second record, contain values of
#
volume and area for each increment of surface-water stage by parcel. The records for each parcel must be
#
sorted in the order of increasing surface-water stage. The first field of each data record must be
#
an integer value representing the parcel number. The second field must be a numeric value of the
#
surface-water stage in feet for the vertical datum represented by the file. The third field is currently unused.
#
The fourth field is a numeric value of the volume in acre-feet at the specified surface-water stage.
#
The fifth field is currently unused. The sixth field is a numeric value of the inundated area in acres
#
for the specified surface-water stage. The remainder of the record should be blank to allow for future options.
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#
Data for subsequent parcels should be appended below the last record for the previous parcel
#
without repeating the header line used in the first record of the file.
#
#
The required naming convention for the data table files are "StageLookupNAVD88.txt" or "StageLookupNGVD29.txt",
#
depending on which vertical datum is being used, NAVD88 or NGVD 29, respectively.
#
The file(s) must be placed in the Tool_Source_Files folder.
#
#
An example of the output showing the header (which is very long) and two lines is show below.
#
Input List of DEMs= E:\Shoreline\ShorelineDirectory\LWRV_5meter_DEM_NAVD88_p27_p31.csv; Columns=
parc_number,
#
refElev_feet, not_used, Volume_acft, not_used, 2D_Area_ac
#
27, 4140.260000, not_used, 530.591431, not_used, 996.295716
#
27, 4140.270000, not_used, 540.465780, not_used, 1002.201601
#
#
Run time depends on DEM resolution, parcel area, number of parcels, stage range, increment level, CPU, and software.
#
The following run times were obtained using the 56.4 sq. mile (146 sq. km) Lower Wood River Valley, Oregon example
#
with stage elevations ranging from 4135.30 - 4176.30 feet;
#
using ArcMap 10.0 SP 5 on a Windows 7 64-bit, processor - Intel Xeon CPU X5570 @ 2.93 GHz, RAM = 3 GB:
#
Resolution
Increment
Increment iterations for each of 34 land parcels
Total iterations
Total time
#
1-m DEM
0.10 ft
411
13,974
4.1 hrs
#
1-m DEM
0.01 ft
4101
139,434
41.9 hrs
#
5-m DEM
0.10 ft
411
13,974
0.8 hrs
#
5-m DEM
0.01 ft
4101
139,434
8.2 hrs
#
Note that it did not appear to take longer if messages were output to the screen for each iteration.
#
######################################################################################################################################
#
# Version
= 2.0
# Version Date = January 23, 2013
# Original Author: Gerry B. Gabrisch Gerry@gabrisch.us November 15, 2005
# Modified by
Curtis V. Price
cprice@usgs.gov
January 22, 2013
# Modified by:
Leonard L. Orzol llorzol@usgs.gov
January 23, 2013
# Modified by:
Daniel T. Snyder dtsnyder@usgs.gov January 23, 2013
# Contact:
Daniel T. Snyder dtsnyder@usgs.gov
#
U.S. Geological Survey (USGS) Oregon Water Science Center
#
http://or.water.usgs.gov
#
######################################################################################################################################
# THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESSED
# OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
# FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL
# THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
# LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
# FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
# DEALINGS IN THE SOFTWARE.
######################################################################################################################################
#
# Issue 1: The following script is used because SurfaceVolume_3d currently (Arc 10.0 SP5)
#
does not have an option for iteration.
#
An enhancement request has been made to Esri to resolve this issue.
#
# Issue 2: Because SurfaceVolume_3d currently (Arc 10.0 SP5) outputs the
#
reference plane elevation with only two decimal places of precision it is
#
necessary to take the output from SurfaceVolume_3d and write a separate

#
output file that preserves the full precision of the reference plane volume.
#
An enhancement request has been made to Esri to resolve this issue.
#
# Assumption 1: The DEM is in elevation units of meters and ground units of meters.
#
Use of a DEM in units other than meters will require modification of the script.
#
# Assumption 2: SurfaceVolume_3d calculates both 2D and 3D areas.
#
2D area is the cumulative area of each cell in the raster projected onto a horizontal datum.
#
3D area is the cumulative area of each cell perpendicular to the slope of the cell.
#
This script is currently written to use 2D area.
#
If 3D area is needed it will require modification of the script.
#
# Warning:
Error messages while running the script might result from previously existing files or directories (though in some
#
instances previously existing directories are required. To avoid some of these errors this script is designed to
#
delete or overwrite some existing files.
#
# Suggestion: To save a text file of the screen output while running this script use the following command:
#
Create_Stagelookup_Data_Table_v2.py | tee Create_Stagelookup_Data_Table_v2_output.txt
#
Note that the "|" is the redirect symbol and "tee" will send output to both the screen and the text file.
#
######################################################################################################################################
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# Import system modules.
import sys
import os
import time
import arcpy
arcpy.CheckOutExtension("3D") # Check out 3D extension license
starttime = time.clock()
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s %s" % ("Starting ", time.strftime("%I:%M:%S", time.localtime())))
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s" % ("Setting Workspace and settings"))

### *************************************************** USER-DEFINED VARIABLES *******************************************************
### **********************************************************************************************************************************
### **********************************************************************************************************************************
### Begin Setting Variables (***!!!these need to be set by user!!!***)
### This is the only place that generally would need to be modified by the user for their project.
###
###
inDEM_list_path = r"F:\ShorelineDirectory\Tool_Source_Files\Python_Scripts" # String: Path to folder with file of input list of DEMs.
###
#
Do not include a trailing "\" at end.
inDEM_list_name = "LWRV_5meter_DEM_NAVD88.csv"
# String: Filename of input list of DEMs.
###
#
This must be a comma delimited text file with no header line.
###
#
The first field is the integer of the land parcel number;
###
#
(should = PARC_NUMBER from the Parcels layer).
###
#
The second is the name of the input DEM.

###
###
###
###
###
###
inDEMpath
###

#
#
#
#
#
= r"F:\ShorelineDirectory\GIS_Layers"

There should be no additional fields on each record.
Two lines from the example file inDEM_list_name
"LWRV_5meter_DEM_NAVD88.csv" are show below:
9,p9_5mdem88
10,p10_5mdem88

# String:
#

Path to input DEMs.
Do not include a trailing "\" at end.
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###
#
Do not include a trailing "\" at end.
inDEMdatum
= "NAVD88"
# String: Vertical datum of input DEMs: NAVD88 or NGVD29.
out_folder_path = r"F:\ShorelineDirectory\Tool_Source_Files" # String: Path to output folder for output text file.
###
#
The file(s) must be located in the folder:
###
#
\ShorelineDirectory\Tool_Source_Files
###
#
Do not include a trailing "\" at end.
###
startElev_feet = 4135.30
# Float:
Start elevation level (units in feet) NOTE: this must be the LOWER elevation value.
endElev_feet
= 4176.30
# Float:
End elevation level
(units in feet) NOTE: this must be the UPPER elevation value.
incElev_feet
= 0.01
# Float:
Elevation increment to use for iteration (units in feet).
#
#
Value will be rounded to "numDecimals" set below.
numDecimals
= 2
# Integer: Number of decimals to round feet elevation values.
zFact
= 1.0
# Float:
Z factor: Set to 1.0 if ground and elevation units of DEM are same units (such as meters).
###
#
See help for SurfaceVolume_3d if DEM ground and elevation units are different.
refPlane
= "BELOW"
# String: Set to ABOVE or BELOW, see the help for SurfaceVolume_3d.
###
#
(selects whether to calculate area & volume above or below given reference plane elev).
###
###
### End Setting Variables (user should not normally need to modify script below this point).
### **********************************************************************************************************************************
### **********************************************************************************************************************************
### **********************************************************************************************************************************

# Prepare output file.
outFile_name
= "StageLookup" + inDEMdatum + ".txt"
#
#
#
#
outFile
= os.path.join(out_folder_path,outFile_name)
# Open listing file.
#
output = open(outFile,"w")

# Name of output text file of elevation, area, and volume .
#
WARNING: will overwrite existing file.
# The required naming convention for the data table files are
#
StageLookupNAVD88.txt or StageLookupNGVD29.txt, depending on
#
vertical datum used, NAVD88 or NGVD 29, respectively.
# Full path and file name of output file.

# Check file.
#
if output is None:
arcpy.AddMessage("%s %s" % ("Error: Unable to open output file ",output_file))
sys.exit( 1 )
# Write to screen the parameters specified for the run.
arcpy.AddMessage("%s" % ("")) #space out screen messages

arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s" % ("USER-SPECIFIED INPUT PARAMETERS:"))
arcpy.AddMessage("%s %s" % ("
Path to folder with file of input list of DEMs (inDEM_list_path)
=",
arcpy.AddMessage("%s %s" % ("
Filename of input list of DEMs
(inDEM_list_name)
=",
arcpy.AddMessage("%s %s" % ("
Path to input DEMs
(inDEMpath)
=",
arcpy.AddMessage("%s %s" % ("
Vertical datum of input DEMs: NAVD88 or NGVD29 (inDEMdatum)
=",
arcpy.AddMessage("%s %s" % ("
Path to output folder for output text file
(out_folder_path)
=",
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s %f" % ("
Starting Elevation, in ft
(startElev_feet) =", startElev_feet))
arcpy.AddMessage("%s %f" % ("
Ending
Elevation, in ft
(endElev_feet)
=", endElev_feet))
arcpy.AddMessage("%s %f" % ("
Increment, in ft
(incElev_feet)
=", incElev_feet))
arcpy.AddMessage("%s %i" % ("
Num. decimals to round elev, in ft (numDecimals)
=", numDecimals))
arcpy.AddMessage("%s %f" % ("
Z-Factor
(zFact)
=", zFact))
arcpy.AddMessage("%s %s" % ("
Reference Plane
(refPlane)
=", refPlane))
arcpy.AddMessage("%s" % ("")) #space out screen messages

inDEM_list_path))
inDEM_list_name))
inDEMpath))
inDEMdatum))
out_folder_path))

inDEM_list_fullpath = os.path.join(inDEM_list_path,inDEM_list_name)
arcpy.AddMessage("%s %s" % ("
Full path and filename of input list of DEMs (inDEM_list_fullpath) =", inDEM_list_fullpath))
arcpy.AddMessage("%s" % ("")) #space out screen messages
inDEM_list
= file(inDEM_list_fullpath, "r" )
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s %s" % ("Output file location:", outFile))
arcpy.AddMessage("%s" % ("")) #space out screen messages

# Print output file location to screen.
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# Write output file header info with column names.
output.write("%s%s%s %s, %s, %s, %s, %s, %s\r\n" % ("Input DEM list=
"refElev_feet","not_used","Volume_acft","not_used","2D_Area_ac"))
# Write screen header
arcpy.AddMessage("%s"
arcpy.AddMessage("%s"
arcpy.AddMessage("%s"
arcpy.AddMessage("%s,

",inDEM_list_fullpath,";

Columns= ","parc_number",\

info with column names (the lines below may be commented out if screen display is not needed).
% ("")) #space out screen messages
% ("")) #space out screen messages
% ("OUTPUT COLUMNS:"))
%s, %s, %s, %s, %s" % ("parcel_number","refElev_feet","not_used","Volume_acre-feet","not_used","2D_Area_acres"))

# Round increment to user-specified number of decimals to prevent deviations due to floating point values.
incElev_feet = round(incElev_feet,numDecimals)
# Iterate through all the DEMs in inDEMList.
for aLine in inDEM_list:
if len(aLine) < 1:
break
parc_numSTR, inDEMname = aLine.split( "," )
inDEM = os.path.join(inDEMpath,inDEMname)
if parc_numSTR is None or parc_numSTR == "":
break
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s, %s" % ("Parcel Number= " + parc_numSTR,"Input DEM= "+ inDEM))
parc_number = int(parc_numSTR)

# Initialize reference plane elevation (in feet) and round to user-specified number of decimals.
refElev_feet = round(startElev_feet,numDecimals)
# Round to prevent deviations due to using floating point values.
# Loop through elevations incrementally to calculate area and volume, writing results to screen and text file.
#
try:
# Return a new output for every change of incElev elevation unit.
# SurfaceVolume appends data if the file exists already.
#
while refElev_feet <= endElev_feet:
refElev_meters = refElev_feet/3.280833
# Reference plane elevation converted to meters.
#
arcpy.env.overwriteOutput = True
# Needed to append each new record to the output file.
# Run the SurfaceVolume_3d program with the user-defined values.
#
arcpy.SurfaceVolume_3d(inDEM, "", refPlane, refElev_meters, zFact)
# Obtain the values or 2D Area, 3D Area, and Volume reported by SurfaceVolume_3d
#
by searching through the output message results string.
#
r = arcpy.GetMessage(2)
area2d_m2 = float(r[r.find("2D Area=") + 8:r.find("3D Area=")])
area3d_m2 = float(r[r.find("3D Area=") + 8:r.find("Volume=")])
vol3d_m3 = float(r[r.find("Volume=")+7:])
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# Convert from
area2d_ac
=
area3d_ac
=
vol3d_acft
=

units of square meters and cubic meters to acres and acre-ft, respectively
area2d_m2 / 4046.873
area3d_m2 / 4046.873
vol3d_m3 / 1233.489

# Report the input and output values to the screen.
arcpy.AddMessage("%i, %f, %s, %f, %s, %f" % (parc_number,refElev_feet,"not_used",vol3d_acft,"not_used",area2d_ac))
# The above line may be commented out if screen display is not needed.
# Write the input and output values to the output file.
output.write("%i, %f, %s, %f, %s, %f\r\n" % (parc_number,refElev_feet,"not_used",vol3d_acft,"not_used",area2d_ac))
# Increment the refPlane elevation and loop and round to user-specified number of decimals
refElev_feet = round(refElev_feet + incElev_feet,numDecimals) # Round to avoid deviations due to floating point values.
except Exception, msg:
arcpy.AddMessage(str(msg))
# Close files.
inDEM_list.close()
output.close()
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s" % ("")) #space out screen messages
stoptime = time.clock()
arcpy.AddMessage("%s %s" % ("DONE: ", time.strftime("%I:%M:%S", time.localtime())))

arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s %s" % ("Output file location =", outFile))
arcpy.AddMessage("%s" % ("")) #space out screen messages
arcpy.AddMessage("%s %.1f" % ("Elapsed time in minutes: ", ((stoptime-starttime)/60)))
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